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Copyright

Dieses Dokument unterliegt dem Copyright © 2010–2024. Die Beitragenden sind unten aufgeführt. 
Sie dürfen dieses Dokument unter den Bedingungen der GNU General Public License 
(http://www.gnu.org/licenses/gpl.html), Version 3 oder höher oder der Creative Commons Attributi-
on License (https://creativecommons.org/licenses/by/4.0/) Version 4.0 oder höher, verändern und/
oder weitergeben.

Warennamen werden ohne Gewährleistung der freien Verwendbarkeit benutzt.

Fast alle Hardware- und Softwarebezeichnungen sowie weitere Stichworte und sonstige Angaben, 
die in diesem Buch verwendet werden, sind als eingetragene Marken geschützt.

Da es nicht möglich ist, in allen Fällen zeitnah zu ermitteln, ob ein Markenschutz besteht, wird das 
Symbol (R) in diesem Buch nicht verwendet.

Mitwirkende/Autoren
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Michael Otto

Englisches Originaldokument

Dieses Kapitel wurde ursprünglich aus dem Englischen übersetzt und basiert auf dem
Impress Chapter 5 – Managing Graphic Objects. Autoren dieses Kapitels sind:
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Rückmeldung

Kommentare oder Vorschläge zu diesem Dokument können Sie in deutscher Sprache an die 
Adresse discuss@de.libreoffice.org senden.

Vorsicht

Alles, was an eine Mailingliste geschickt wird, inklusive der E-Mail-Adresse und 
anderer persönlicher Daten, die die E-Mail enthält, wird öffentlich archiviert und kann 
nicht gelöscht werden. Also, schreiben Sie bitte mit Bedacht!

Datum der Veröffentlichung und Softwareversion

Veröffentlicht am 31.05.2024. Basierend auf der LibreOffice Version 24.2.
Andere Versionen von LibreOffice können sich im Aussehen und der Funktion unterscheiden.
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Verwendung von LibreOffice unter macOS

Einige Tastenbelegungen und Menüeinträge unterscheiden sich zwischen der Macintosh-Version 
und denen für Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen einige grundle-
gende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der Hilfe der jeweiligen 
Komponente.

In Windows/Linux entspricht unter macOS Effekt
Menü
Extras > Optionen

LibreOffice > Einstellungen Zugriff auf die Programmoptionen

RECHTSKLICK

CTRL+KLICK und/oder 
RECHTSKLICK je nach 
Einstellungen

Öffnen eines Kontextmenüs

STRG (Steuerung) ⌘ (Command)
Tastenkürzel in Verbindung mit anderen 
Tasten

ALT ⌥ und/oder Alt oder Option
Tastenkürzel in Verbindung mit anderen 
Tasten

F11 ⌘+T
Öffnen der Formatvorlagen in der 
Seitenleiste

Synonyme

In diesem Dokument verwendete Synonyme:

für

Abschnitt

Deck

Dialogfeld, Dialogbox

Dropdown-

Anfasser (Punkte am Ende einer Symbolleiste)

Menüleiste, Hauptmenü,

Popup-Menü

Register, Reiter

Tabulator

Objektpunkte (quadratisch, rund, oval)

in diesem Dokument verwendet

Bereich

Bereich

Dialog

Auswahl-

Griff(e)

Menü

Menü

Tab

Tabulator

Ziehpunkte

Viele Begriffe im Bezug zu LibreOffice und den darin verwendeten Techniken finden Sie im 
Glossar. Das Handbuch Glossar wurde für alle Komponenten von LibreOffice erstellt und kann im 
Bereich „Erste Schritte‟ ganz unten herunter geladen werden.

Sie sehen vielleicht etwas anderes

LibreOffice läuft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von denen 
jedes Betriebssystem unterschiedliche Versionen hat und kann von den Nutzern bezüglich Schrift-
arten, Farben und Themen angepasst werden.

Die Bilder in diesem Handbuch wurden mit hellem Thema in Windows 10 erstellt. Das LibreOffice 
Thema entspricht der Werkseinstellungen.
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Einführung

In diesem Kapitel wird beschrieben, wie Sie mit den in Impress verfügbaren Werkzeugen (Symbo-
len) grafische Objekte auf einer Folie drehen, verzerren, anordnen und positionieren können. 
Einige der in diesem Kapitel beschriebenen Techniken können jedoch auch auf Bilder auf Folien 
angewendet werden.

Symbolleiste „Zeichnung‟

Die Symbolleiste Zeichnung (Abbildung 2) enthält die meisten Werkzeuge, die normalerweise zum 
Erstellen von Grafikobjekten verwendet werden. Wenn diese Symbolleiste nicht sichtbar ist, 
wählen Sie im Menü Ansicht > Symbolleisten > Zeichnung. Standardmäßig ist die Symbolleiste 
Zeichnung vertikal an der linken Seite des Impress-Fensters angedockt.

Außerdem hängt die angezeigte Symbolleiste Zeichnung davon ab, wie viele Symbole auf der 
Symbolleiste eingerichtet wurden. KLICKEN Sie mit der rechten Maustaste in einen leeren Bereich 
der Symbolleiste Zeichnung und wählen Sie dann im Kontextmenü Sichtbare Schaltflächen, um 
die verfügbaren Symbole anzuzeigen. Sie können weitere Symbole hinzufügen (sind dann hellblau 
hinterlegt) oder Symbole entfernen (neutral), Abbildung 1.

Abbildung 1: Kontextmenü „Sichtbare Schaltflächen‟

Hinweis

Die in Abbildung 2 gezeigte Symbolleiste Zeichnung kann sich je nach Betriebssystem 
und Einrichtung unterscheiden.
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Abbildung 2: Symbolleiste „Zeichnung‟

Die Symbole in der Symbolleiste Zeichnung Abbildung 2 haben folgende Funktionen:

1 Auswahl

2 Vergrößern und verschieben

3 Textfeld einfügen

4 Vertikalen Text einfügen

5 Linienfarbe

6 Füllfarbe

7 Linie einfügen

8 Rechteck

9 Ellipse

10 Linien und Linienspitzen

11 Kurven und Polygone

12 Verbinder

13 Grundformen

14 Symbolformen

15 Blockpfeile

16 Flussdiagramme

17 Legenden

18 Sterne und Banner

19 3D-Objekte

20 Drehen

21 Objekte ausrichten

22 Anordnen

23 Verteilen (min. 3 Objekte)

24 Schatten

25 Bild zuschneiden

26 Filter

27 Punktbearbeitungsmodus

28 Klebepunkte

29 Extrusion umschalten

Die Symbole werden im Nachfolgenden erläutert.

Auswahl 

Dient zur Auswahl von Objekten. Um eine Gruppe von Objekten auszuwählen, positionieren Sie 
den Cursor über dem oberen linken Objekt, KLICKEN und halten Sie den Cursor und ziehen Sie ihn 
unter das untere rechte Objekt der gewünschten Auswahl. Es wird ein Rechteck angezeigt, das 
den Auswahlbereich kennzeichnet (auch als Markierung bezeichnet). Sie können auch mehrere 
Objekte auswählen, indem Sie die UMSCHALT-Taste gedrückt halten, während Sie die einzelnen 
Objekte ANKLICKEN.

Vergrößern und verschieben 

Dient zum Vergrößern und Verschieben der ausgewählten Folie im Arbeitsbereich. Wählen Sie das 
Symbol Vergrößern und verschieben aus. Sie können nun mit einem KLICK die Bildschirmdar-
stellung der Folie vergrößern und verkleinern mit STRG+KLICK. Mit gehaltener UMSCHALT-Taste und 
der linken MAUSTASTE können Sie die Folie verschieben. Der aktuelle Zoomfaktor wird als 
Prozentwert in der Statusleiste angezeigt.

Textfeld einfügen 

Erzeugt ein Textfeld mit horizontal ausgerichtetem Text. Weitere Informationen zur Arbeit mit Text 
finden Sie in Impress Kapitel 3 - Text hinzufügen und formatieren.
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Vertikalen Text einfügen 

Erzeugt ein Textfeld mit vertikal ausgerichtetem Text. Dieses Symbol ist nur verfügbar, wenn die 
Unterstützung für asiatische Sprachen unter Extras > Optionen > Sprachen und Gebietssche-
ma > Allgemein aktiviert wurde. Weitere Informationen zur Arbeit mit Text finden Sie in 
 Impress Kapitel 3 - Text hinzufügen und formatieren.

Linienfarbe 

KLICKEN Sie auf das Dreieck  neben Linienfarbe, um eine Farbpalette zu öffnen und eine Farbe 
für die Linie auszuwählen. Weitere Farben sind verfügbar, indem Sie eine andere Farbpalette aus 
der Auswahl-Liste oben in der Farbpalette auswählen, Abbildung 3.

Abbildung 3: Auswahl der Linienfarbe aus einer Farbpalette. Rechts die 
Auswahlliste der Farbpaletten. Diese Liste kann in Ihrem System anders 
aussehen

Füllfarbe 

KLICKEN Sie auf das Dreieck  neben Füllfarbe, um eine Farbpalette zu öffnen und eine Farbe für 
die Flächenfüllung auszuwählen. Weitere Farben sind verfügbar, indem Sie eine andere Farbpalet-
te aus der Auswahl-Liste oben in der Farbpalette auswählen, Abbildung 3.

Linie einfügen 

Zeichnet eine gerade Linie von dem Punkt, wo Sie mit der Maus KLICKEN-HALTEN-ZIEHEN, bis zu 
dem Punkt wo der Cursor hingezogen wird und lassen Sie den Cursor los. Drücken Sie die 
UMSCHALT-Taste, um den Winkel der Linie auf Vielfache von 45° zu beschränken. Drücken Sie die 
ALT-Taste, um eine Linie von der Mitte aus zu zeichnen. Lassen Sie die MAUSTASTE los, bevor Sie 
die UMSCHALT- oder ALT-Taste loslassen.

Rechteck 

Zeichnet ein Rechteck, wenn der Cursor diagonal gezogen wird. Drücken Sie die UMSCHALT-Taste, 
um ein Quadrat zu zeichnen. Drücken Sie die ALT-Taste, um eine Form von der Mitte aus zu zeich-
nen. Drücken Sie die Tasten UMSCHALT+ALT, um ein Quadrat von der Mitte aus zu zeichnen. 
Lassen Sie die MAUSTASTE los, bevor Sie die UMSCHALT- oder ALT-Taste loslassen.
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Ellipse 

Zeichnet eine Ellipse. Drücken Sie die UMSCHALT-Taste, um einen Kreis zu zeichnen. Drücken Sie 
die ALT-Taste, um eine Form vom Mittelpunkt aus zu zeichnen. Drücken Sie die Tasten 
UMSCHALT+ALT, um einen Kreis vom Mittelpunkt aus zu zeichnen. Lassen Sie die MAUSTASTE los, 
bevor Sie die UMSCHALT- oder ALT-Taste loslassen.

Linien und Linienspitzen 

Zeichnet eine gerade Linie, die mit einer Pfeilspitze endet. Die Pfeilspitze wird an dem Ende der 
Linie platziert, an dem die MAUSTASTE losgelassen wird. KLICKEN Sie auf das Dreieck  neben 
Linien und Linienspitzen, um die verfügbaren Optionen für Linien und Pfeile anzuzeigen (Abbildung
4). Die UMSCHALT- und ALT-Tasten haben die gleiche Wirkung wie bei dem Symbol Linie einfügen. 
Das tatsächlich angezeigte Symbol hängt davon ab, welches Symbol zuvor ausgewählt worden 
war.

Abbildung 4: Symbolleiste „Linien und Pfeile‟

Kurven und Polygone 

Zeichnet eine Form in Abhängigkeit von der gewählten Option. KLICKEN Sie auf das Dreieck  
neben Kurven und Polygone, um die verfügbaren Optionen für Kurven und Polygone anzuzeigen 
(Abbildung 5). Das tatsächlich angezeigte Symbol hängt von dem zuvor ausgewählten Symbol ab.

Abbildung 5: Symbolleiste „Kurven 
und Polygone‟

Verbinder 

Zeichnet eine Verbindungslinie zwischen zwei Objekten. KLICKEN Sie auf das Dreieck  neben 
Verbinder, um die verfügbaren Optionen für Verbinder anzuzeigen (Abbildung 6). Das tatsächlich 
angezeigte Symbol hängt von dem zuvor ausgewählten Symbol ab. Weitere Informationen finden 
Sie unter „Verbinder und Klebepunkte‟ weiter unten.

Abbildung 6: Symbolleiste „Verbinder‟

Grundformen 

KLICKEN Sie auf das Dreieck  neben Grundformen, um die verfügbaren Optionen für Grundformen 
anzuzeigen (Abbildung 7). Die UMSCHALT- und ALT-Tasten haben die gleiche Wirkung wie beim 
Rechteck-Symbol. Das tatsächlich angezeigte Symbol hängt davon ab, welches Symbol zuvor 
ausgewählt worden war.
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Abbildung 7: Symbolleiste „Grundformen‟

Symbolformen 

KLICKEN Sie auf das Dreieck  neben Symbolformen, um die verfügbaren Optionen für Symbolfor-
men anzuzeigen (Abbildung 8). Die UMSCHALT- und ALT-Tasten haben die gleiche Wirkung wie 
beim Rechteck-Symbol. Das tatsächlich angezeigte Symbol hängt davon ab, welches Symbol 
zuvor ausgewählt worden war.

Abbildung 8: Symbolleiste „Symbolformen‟

Blockpfeile 

KLICKEN Sie auf das Dreieck  neben Blockpfeile, um die verfügbaren Optionen für Blockpfeile 
anzuzeigen (Abbildung 9). Die UMSCHALT- und ALT-Tasten haben die gleiche Wirkung wie beim 
Rechteck-Symbol. Das tatsächlich angezeigte Symbol hängt davon ab, welches Symbol zuvor 
ausgewählt worden war.

Abbildung 9: Symbolleiste „Blockpfeile‟

Flussdiagramme 

KLICKEN Sie auf das Dreieck  neben Flussdiagramm, um die verfügbaren Optionen für Flussdia-
grammformen anzuzeigen (Abbildung 10). Die UMSCHALT- und ALT-Tasten haben die gleiche 
Wirkung wie beim Rechteck-Symbol. Das tatsächlich angezeigte Symbol hängt von dem Symbol 
ab, das zuvor ausgewählt wurde.

Abbildung 10: Symbolleiste „Flussdiagramme‟
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Legenden 

KLICKEN Sie auf das Dreieck  neben Legenden, um die verfügbaren Optionen für Legenden-Be-
schriftung anzuzeigen (Abbildung 11). Die UMSCHALT- und ALT-Tasten (haben die gleiche Wirkung 
wie beim Rechteck-Symbol. Das tatsächlich angezeigte Symbol hängt von dem Symbol ab, das 
zuvor ausgewählt wurde.

Abbildung 11: Symbolleiste 
„Legenden‟

Sterne und Banner 

KLICKEN Sie auf das Dreieck  neben Sterne und Banner, um die verfügbaren Optionen für Sterne 
und Banner anzuzeigen (Abbildung 12). Die UMSCHALT- und ALT-Tasten haben die gleiche Wirkung 
wie beim Rechteck-Symbol. Das tatsächlich angezeigte Symbol hängt davon ab, welches Symbol 
zuvor ausgewählt worden war.

Abbildung 12: Symbolleiste „Sterne und Banner‟

3D-Objekte 

KLICKEN Sie auf das Dreieck  neben 3D-Objekte, um die verfügbaren Optionen für 3D-Objekte 
anzuzeigen (Abbildung 13). Die UMSCHALT- und ALT-Tasten haben die gleiche Wirkung wie beim 
Rechteck-Symbol. Das tatsächlich angezeigte Symbol hängt davon ab, welches Symbol zuvor 
ausgewählt worden war. Alternativ können Sie im Menü Ansicht > Symbolleisten > 3D-Objekte 
wählen, um die Symbolleiste 3D-Objekte zu öffnen. Weitere Informationen zu 3D-Objekten finden 
Sie unter „Arbeiten mit 3D-Objekten‟ weiter unten.

Abbildung 13: Symbolleiste „3D-
Objekte‟

Drehen 

Wählen Sie ein Objekt aus und KLICKEN Sie dann auf das Symbol Drehen, um 
das Objekt in den Drehmodus zu versetzen. Die Ziehpunkte ändern ihre Farbe 
und der Drehpunkt erscheint in der Mitte des Objekts, Abbildung 14.

Objekte ausrichten 

KLICKEN Sie auf das Dreieck  neben Objekte ausrichten, um die verfügbaren Optionen für die 
Ausrichtungssymbole für zwei oder mehr Objekte anzuzeigen, Abbildung 15. Alternativ dazu 
können Sie im Menü Ansicht > Symbolleisten > Objekte ausrichten wählen, um die Symbolleis-
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te Objekte ausrichten zu öffnen. Weitere Informationen finden Sie unter „Objekte ausrichten‟ weiter 
unten. Die Symbole von links nach rechts:

Links, Zentriert, Rechts - Bestimmt die horizontale Ausrichtung der ausgewählten Objekte.

Oben, Mitte, Unten - Legt die vertikale Ausrichtung der ausgewählten Objekte fest.

Abbildung 15: Symbolleiste 
„Objekte ausrichten‟

Anordnen 

Ändert die Stapelebene eines Objekts. Da Objekte in unterschiedlichen Ebenen liegen können, 
kann ein Objekt ein anderes darunterliegendes Objekt verdecken, dies wird auf Seite 44 näher 
erläutert. KLICKEN Sie auf das Dreieck  neben Anordnen, um die verfügbaren Optionen zum 
Anordnen der Stapelebenen der ausgewählten Objekte anzuzeigen (Abbildung 16). Alternativ 
können Sie auch das gewünschte Symbol in der Symbolleiste Linie und Füllung auswählen. 
Weitere Informationen finden Sie unter „Anordnen von Objekten‟ weiter unten.

Ganz nach vorn - Das ausgewählte Objekt wird vor alle anderen Objekte verschoben.

Weiter nach vorn - Das markierte Objekt wird im Stapel eine Ebene nach oben verschoben.

Weiter nach hinten - Das markierte Objekt wird im Stapel eine Ebene nach unten verschoben.

Ganz nach hinten - Das markierte Objekt wird hinter alle anderen Objekte verschoben.

Vor das Objekt - Verschiebt das erste ausgewählte Objekt vor das zweite ausgewählte Objekt.

Hinter das Objekt - Verschiebt das erste markierte Objekt hinter das zweite markierte Objekt.

Vertauschen - Vertauscht die Stapelreihenfolge von zwei ausgewählten Objekten.

Abbildung 16: Symbolleiste 
„Reihenfolge‟ (Anordnung‟

Verteilen 

Ändert die Verteilung zwischen den Objekten durch die Verwendung des horizontalen und vertika-
len Abstands zwischen den Objekten. KLICKEN Sie auf das Dreieck  neben dem Symbol Verteilen. 
Wählen Sie mindestens drei zu verteilende Objekte aus, um die verfügbaren Symbole anzuzeigen, 
Abbildung 17. Alternativ können Sie auch im Menü Ansicht > Symbolleisten > Auswahl 
verteilen wählen, um die Symbolleiste Auswahl verteilen zu öffnen. Damit die Symbole aktiv sind, 
müssen mindestens drei Objekte ausgewählt werden.

Horizontal links - Verteilt die ausgewählten Objekte so, dass die linken Kanten der Objekte gleich-
mäßig voneinander entfernt sind.

Horizontal mittig - Verteilt die markierten Objekte so, dass die horizontalen Mittelpunkte der 
Objekte gleichmäßig voneinander im Abstand stehen.

Horizontal mit Abstand - Verteilt die markierten Objekte horizontal, so dass die Objekte einen 
gleichmäßigen Abstand zueinander haben.
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Horizontal rechts - Verteilt die markierten Objekte so, dass die rechten Kanten der Objekte gleich-
mäßig voneinander entfernt sind.

Vertikal oben - Verteilt die markierten Objekte so, dass die oberen Kanten der Objekte gleichmäßig 
voneinander im Abstand stehen.

Vertikal mittig - Verteilt die ausgewählten Objekte so, dass die vertikalen Mittelpunkte der Objekte 
gleichmäßig voneinander im Abstand stehen.

Vertikal mit Abstand - Verteilt die ausgewählten Objekte vertikal, so dass die Objekte gleichmäßig 
voneinander im Abstand stehen.

Vertikal Unten - Verteilt die ausgewählten Objekte so, dass die unteren Kanten der Objekte gleich-
mäßig voneinander im Abstand stehen.1

Abbildung 17: Symbolleiste „Auswahl 
verteilen‟ (Verteilen)

Schatten 

Wendet einen Schatten auf ein ausgewähltes Objekt an, wobei die Einstellungen für den Schatten, 
je nach Objekt, aus dem Dialog Fläche oder Linie verwendet werden.

Bild zuschneiden 

Das Symbol Bild zuschneiden wird nur aktiv, wenn ein Bild ausgewählt ist, das beschnitten werden 
kann. KLICKEN Sie auf das Symbol Bild zuschneiden, damit das Bild die Ziehpunkte, die nun eine 
blaue Farbe angenommen haben, erhält.

Filter 

Das Symbol Filter wird nur aktiv, wenn ein Bild ausgewählt ist und öffnet die verfügbaren Filteropti-
onen in der Symbolleiste Grafikfilter (Abbildung 18) zur Anwendung auf ein Bild. Weitere Informati-
onen zu Grafikfilter finden Sie im Handbuch Draw Kapitel 6 Bilder Bearbeiten.

Invertieren - Invertiert die Farbwerte eines Farbbildes bzw. die Helligkeitswerte eines Graustufen-
bildes. Wenden Sie den Filter erneut an, um den Effekt umzukehren.

Weichzeichnen - Macht das Bild durch Anwendung eines Tiefpassfilters weicher oder unschärfer.

Schärfen - Schärft das Bild mit einem Hochpassfilter.

Rauschen entfernen - Entfernt Rauschen durch Anwendung eines Medianfilters.

Solarisation - Öffnet ein Dialog zur Definition der Solarisation. Solarisation bezieht sich auf einen 
Effekt, der so aussieht, wie er bei zu viel Licht während der Fotoentwicklung auftreten kann.

Altern - Alle Pixel werden auf ihre Grauwerte gesetzt. Die grünen und blauen Farbkanäle werden 
dann um den von Ihnen angegebenen Wert reduziert. Der rote Farbkanal wird nicht verändert.

Poster - Öffnet einen Dialog, um die Anzahl der Plakatfarben zu bestimmen. Dieser Effekt basiert 
auf der Reduzierung der Anzahl der Farben. Er lässt Fotos wie Gemälde aussehen.

Pop Art - Konvertiert ein Bild in ein Pop-Art-Format.

Kohlezeichnung - Zeigt das Bild als Kohleskizze an. Die Konturen des Bildes werden in Schwarz 
gezeichnet und die ursprünglichen Farben werden unterdrückt.

1 „Eine Typische Verwendung wäre, mehrere nebeneinander liegende Objekte zuerst Horizontal mit Abstand 
und dann Vertikal oben auszurichten.“
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Relief - Zeigt einen Dialog zum Erstellen von Reliefs an. Sie können die Position der möglichen 
Lichtquelle wählen, die die Art des erzeugten Schattens bestimmt und wie das grafische Bild im 
Relief aussieht.

Mosaik - Fügt kleine Gruppen von Pixeln zu rechteckigen Flächen derselben Farbe zusammen. Je 
größer die einzelnen Rechtecke sind, desto weniger Details weist die Grafik auf.

Abbildung 18: Symbolleiste „Grafikfilter‟

Punktbearbeitungsmodus umschalten 

Wählen Sie das Symbol Punktbearbeitungsmodus umschalten und dann ein Objekt aus, um die 
einzelnen Punkte des Objekts zu bearbeiten. Das Objekt muss zunächst in eine Kurve oder ein 
Polygon umgewandelt werden, bevor die Objektpunkte bearbeitet werden können. Durch KLICKEN 
auf das Tastaturkürzel F8 wird diese Funktion ebenfalls ausgewählt.

Klebepunkte 

Öffnet die Symbolleiste Klebepunkte (Abbildung 19) zum Bearbeiten der Klebepunkte eines Grafik-
objekts. Klebepunkte an Objekten ermöglichen das Andocken von Verbinder (Verbinderlinien) -
Enden oder -Anfängen. Weitere Informationen finden Sie unter „Klebepunkte‟ weiter unten.

Abbildung 19: Symbolleiste „Klebepunkte‟

Linien und Formen erstellen

Dieser Abschnitt ist eine Einführung in die Erstellung von Linien und Formen zur Verwendung in 
Präsentationen. Weitere Informationen zur Arbeit mit Linien und Formen finden Sie im 
Handbuch Draw Kapitel 2 Zeichnen von Formen.

Zeichnen regelmäßiger Formen

In der Symbolleiste Zeichnung sind die folgenden regulären Formen verfügbar:

Einige Symbole für regelmäßige Formen haben ein Dreieck  neben dem Symbol, das den Zugriff 
auf weitere verschiedene Arten von regulären Formen ermöglicht. Außerdem zeigen die Symbole 
für einige der regulären Formen in der Symbolleiste Zeichnung das zuletzt verwendete Symbol für 
jede dieser regulären Formen an.

Linien und Formen erstellen 15
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• Ellipse

• Grundformen
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• Blockpfeile

• Flussdiagramme

• Legenden

• Sterne und Banner

• 3D-Objekte
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1. Wählen Sie das gewünschte Symbol aus der Symbolleiste Zeichnung oder einer Symbol-
leiste, nachdem Sie das Dreieck  neben dem Symbol ausgewählt haben.

2. Platzieren Sie den Cursor auf der Folie und KLICKEN-HALTEN-ZIEHEN Sie, um ein umschlie-
ßendes Rechteck zu definieren.

3. Lassen Sie die MAUSTASTE los und die ausgewählte Form wird auf der Folie gezeichnet.

4. Halten Sie beim Erstellen einer Form die UMSCHALT-Taste gedrückt, um das Verhältnis 
zwischen Höhe und Breite beizubehalten. Verwenden Sie zum Beispiel Rechteck oder 
Ellipse, um ein Quadrat oder einen Kreis zu zeichnen. Lassen Sie die MAUSTASTE los, 
bevor Sie die UMSCHALT-Taste loslassen.

5. Halten Sie die ALT-Taste gedrückt, um eine Form von der Mitte aus zu zeichnen. Lassen 
Sie die MAUSTASTE los, bevor Sie die ALT-Taste loslassen.

6. Halten Sie beim Erstellen einer Form die UMSCHALT- und ALT-Taste gedrückt, um die 
gleiche Höhe und Breite beizubehalten beziehungsweise die Form von der Mitte aus zu 
zeichnen, wenn Sie mit dem Rechteck- oder Ellipsensymbol ein Quadrat oder einen Kreis 
zeichnen. Lassen Sie die MAUSTASTE los, bevor Sie die UMSCHALT- und ALT-Tasten 
loslassen.

7. Halten Sie die STRG-Taste gedrückt, wenn Sie eine Form erstellen, um die obere linke Ecke 
des Formauswahlfelds am nächstgelegenen Rasterpunkt zu fangen.

Hinweis

Wenn die Option Am Raster fangen unter Extras > Optionen > LibreOffice Impress 
> Raster > Am Raster fangen aktiviert wurde, verhindert das Gedrückthalten der 
STRG-Taste, dass die obere linke Ecke des Formauswahlrahmens am nächstgelege-
nen Rasterpunkt einrastet.

Anpassung der Form

Beim Erstellen von Formen, die in Impress enthalten sind, können ein oder mehrere Punkte in 
einer anderen Farbe als die Ziehpunkte angezeigt werden. Diese Punkte führen je nach Form eine 
unterschiedliche Anpassung durch. Die Bewegungsrichtung dieser Punkte ist jeweils in Spalte B 
der Tabellen dargestellt.

Grundformen

Grundformen Funktion zur Anpassung der Form B
Abgerundetes Rechteck oder 
Quadrat

Ändert den Radius der Kurve, die für die Ecken eines 
abgerundeten Rechtecks oder Quadrats verwendet wird.

↔

Parallelogramm, Trapezoid Ändert die Innenwinkel zwischen den Seiten. ↔
Kreissektor Verändert die Größe des gefüllten Sektors. ◌

Ellipsenbogen
Ändert sowohl den Innendurchmesser als auch die Größe 
der gefüllten Fläche.

◌

Gleichschenkliges Dreieck Ändert die Form und den Typ des Dreiecks. ↔
Sechseck, Achteck Ändert die Innenwinkel zwischen den Seiten. ↔
Zylinder,Würfel Verändert die Perspektive. ↔
Gefaltete Ecke Ändert die Größe der gefalteten Ecke. ↔
Kreuz Ändert die Dicke der vier Kreuzarme. ↔
Rahmen Ändert die Dicke des Rahmens. ↕
Ring Ändert den inneren Durchmesser des Rings. ↔
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Symbolformen

Symbolformen Funktion zur Anpassung der Form B
Smiley Gesicht Verändert das Lächeln auf dem Gesicht. ↕
Sonne, Mond Ändert die Form des Symbols. ↔
Verboten Ändert die Dicke des Rings und des Diagonalstabs. ↔
Bilderrahmen, 
Achteckiger, 
Rautenförmiger

Ändert die Dicke der Abschrägung. ↔

Runde u 
Geschweifte (einf.) 
Klammern

Ändert die Krümmung der Klammer. ↕

Geschweifte 
Klammern (dopp.)

Ändert die Krümmung der Klammer. ↔

Blockpfeile

Blockpfeile Funktion zur Anpassung der Form B
Pfeil nach rechts, Pfeil 
nach links, Pfeil nach 
unten, Pfeil nach 
oben, Pfeil im Kreis, 
Geschwungener Pfeil, 
Pfeil mit Gabelung, 
Pfeil rechts oder links, 
Pfeil in alle Richtungen

Ändert die Form und Dicke des Pfeils. ↕↔

Pfeil nach oben, rechts 
und unten, Doppelpfeil 
oben-rechts, Gestreif-
ter Pfeil nach rechts, 
Eingekerbter 
Richtungspfeil,

Ändert den Winkel zwischen den Seiten und der Form. ↕↔

Legende mit Pfeil(en) 
nach – rechts, links, 
unten, oben, links und 
rechts, oben und 
unten, in alle Richtun-
gen, oben und rechts.

Ändert die Form und Dicke der Legende. ↕↔

Legenden
Alle Legenden verwenden Einstellungspunkte, um die Länge, Positi-
on und den Winkel des Zeigers zu ändern (B=◌).

◌

Sterne und Banner

Sterne und Banner Funktion zur Anpassung der Form B
Stern mit 4, 8, 24 Zacken Ändert die Dicke und Form der Sternpunkte. ↔
Vertikale, Horizontale Schriftrolle Ändert die Breite und Form der Schriftrolle. ↕↔
Türschild Ändert die Innenwölbung der Ecken. ↔

Zeichnen von Kurven, Polygonen und Freiformlinien

Kurven, Polygone und Linien in der Symbolleiste Zeichnung haben ein Dreieck  neben dem 
Symbol. Wenn Sie auf dieses Dreieck  KLICKEN, öffnet sich eine Symbolleiste, die Zugang zu 
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verschiedenen Arten von Kurven, Polygonen und Linien bietet. Die Symbole in der Symbolleiste 
Zeichnung zeigen das zuletzt verwendete Symbol für jede dieser Kurven, Polygone und Linien an. 
Wenn eine gefüllte Kurve, ein gefülltes Polygon oder eine gefüllte Freiformlinie ausgewählt ist, 
zeichnet Impress eine Verbindungslinie zwischen dem letzten Punkt und dem Startpunkt und füllt 
den inneren Bereich mit der Standardfüllfarbe.

Kurven

1. KLICKEN Sie auf das Dreieck  neben Kurven und Polygone in der Symbolleiste Zeichnung, 
um die Symbolleiste Kurven und Polygone zu öffnen.

2. Wählen Sie entweder Kurve oder Kurve ausgefüllt.

3. Platzieren Sie den Cursor auf der Folie und KLICKEN-HALTEN-ZIEHEN Sie, um den Startpunkt 
einer Kurve und die Form zu erstellen.

4. Lassen Sie die MAUSTASTE los und ziehen Sie den Cursor, um eine Kurve auf der Folie zu 
zeichnen, wobei die Linie zu einer Kurve gebogen wird.

5. KLICKEN Sie, um den Endpunkt der Kurve festzulegen und die Kurve auf der Folie zu 
fixieren.

6. Ziehen Sie den Mauszeiger, um mit dem Zeichnen einer geraden Linie fortzufahren. Jeder 
KLICK setzt einen Eckpunkt und ermöglicht das Zeichnen einer weiteren geraden Linie vom 
Eckpunkt aus.

7. DOPPELKLICKEN Sie, um das Zeichnen der Kurve zu beenden. Wenn die Option Kurve 
ausgefüllt ausgewählt wurde, füllt Impress die Kurve automatisch mit der Standardfüllfarbe.

Hinweis

Wenn Sie beim Zeichnen von Linien mit dem Kurven- oder Polygonwerkzeug die 
UMSCHALT-Taste gedrückt halten, werden die Winkel zwischen den Linien auf 45° oder 
90° begrenzt.

Polygone und Polygone 45°

1. KLICKEN Sie auf das Dreieck  neben Kurven und Polygone in der Symbolleiste Zeichnung, 
um die Symbolleiste Kurven und Polygone zu öffnen.

2. Wählen Sie entweder Polygon oder Polygon ausgefüllt, Polygon (45°) oder Polygon ausge-
füllt (45°).

3. Platzieren Sie den Cursor auf der Folie und KLICKEN-HALTEN-ZIEHEN Sie, um die erste Linie 
vom Startpunkt aus zu zeichnen. Wenn Sie die MAUSTASTE loslassen, wird eine Linie 
zwischen dem ersten und zweiten Punkt gezeichnet.

4. Bewegen Sie den Cursor, um die nächste Linie zu zeichnen. Jeder KLICK setzt einen 
Eckpunkt und ermöglicht das Zeichnen einer weiteren Linie.

5. DOPPELKLICKEN Sie, um das Zeichnen eines Polygons zu beenden. Wenn Polygon gefüllt 
oder Polygon gefüllt (45°) ausgewählt wurde, füllt Impress das Polygon automatisch mit der 
Standardfüllfarbe.

Hinweis

Wenn Polygon (45°) oder Polygon gefüllt (45°) ausgewählt wurde, ist die Bewegung 
des Cursors und der Winkel zwischen den Linien auf 45°-Schritte beschränkt.
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Freihandlinie

Die Verwendung der Symbole Freiformlinie oder Freiformlinie ausgefüllt ähnelt dem Zeichnen mit 
einem Bleistift auf Papier.

1. KLICKEN Sie auf das Dreieck  neben Kurven und Polygone in der Symbolleiste Zeichnung, 
um die Symbolleiste Kurven und Polygone zu öffnen.

2. Wählen Sie entweder Freiformlinie oder Freiformlinie ausgefüllt.

3. KLICKEN-HALTEN-ZIEHEN Sie den Cursor auf die gewünschte Linienform.

4. Wenn Sie mit dem Zeichnen einer Freiformlinie fertig sind, lassen Sie den Cursor los und 
die Zeichnung ist abgeschlossen. Wenn Sie die Option Freiformlinie gefüllt gewählt haben, 
füllt Impress die Zeichnung zwischen dem Start- und Endpunkt automatisch mit der 
Standardfüllfarbe.

Zeichnen von Linien und Pfeilen

Gerade Linien

Eine gerade Linie ist das am einfachsten zu erstellende Element oder Objekt in Impress.

1. Verwenden Sie eine der folgenden Methoden, um eine Linie zu zeichnen:

○ KLICKEN Sie in der Symbolleiste Zeichnung auf Linie einfügen.

○ KLICKEN Sie auf das Dreieck  rechts neben Linien und Linienspitzen in der Symbolleis-
te Zeichnung und wählen Sie Linie einfügen aus der Symbolleiste Linien und Pfeile.

2. KLICKEN Sie auf die Startposition der Linie, halten Sie die MAUSTASTE gedrückt und ziehen 
Sie den Cursor von der Startposition zur Endposition der Linie und lassen die MAUSTASTE 
los. An jedem Ende der Linie wird ein Ziehpunkt angezeigt. Der Ziehpunkt am Startpunkt 
der Linie ist größer als der Ziehpunkt am Endpunkt.

3. Halten Sie die STRG-Taste gedrückt, während Sie eine Linie zeichnen, damit das Ende der 
Linie am nächstgelegenen Rasterpunkt einrastet.

4. Halten Sie die UMSCHALT-Taste gedrückt, während Sie eine Linie zeichnen, um den Zeich-
nungswinkel einer Linie auf ein Vielfaches von 45° zu beschränken.

5. Halten Sie beim Zeichnen einer Linie die ALT-Taste gedrückt, damit sich die Linie vom 
Startpunkt aus symmetrisch in beide Richtungen ausdehnt. Dadurch werden Linien 
gezeichnet, die in der Mitte der Linie beginnen sollen.

Pfeile

Pfeile werden wie Linien gezeichnet und sind eine Untergruppe von Linien, das heißt Linien mit 
Linienspitzen. Wenn Sie den Mauszeiger über die einzelnen verfügbaren Pfeiltypen bewegen, 
erhalten Sie ein Tooltipp der die Art der Enden, die jedes Symbol zeichnet, beschreibt.

1. KLICKEN Sie auf das Dreieck  rechts neben Linien und Linienspitzen in der Symbolleiste 
Zeichnung und wählen Sie den Typ in der Symbolleiste Linien und Pfeile aus.

2. KLICKEN-HALTEN-ZIEHEN Sie den Cursor von der Anfangsposition des Pfeils und lassen Sie 
am Ende los. Die Pfeilspitze wird am Ende der Linie gezeichnet.

3. Halten Sie die STRG-Taste gedrückt, während Sie einen Pfeil zeichnen, damit das Ende des 
Pfeils am nächstgelegenen Rasterpunkt einrastet.

4. Halten Sie beim Zeichnen eines Pfeils die UMSCHALT-Taste gedrückt, um den Zeichenwin-
kel eines Pfeils auf ein Vielfaches von 45° zu beschränken.
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5. Halten Sie die ALT-Taste gedrückt, während Sie einen Pfeil zeichnen, damit sich der Pfeil 
vom Startpunkt aus symmetrisch in beide Richtungen ausdehnt. Dadurch werden Pfeile 
von der Mitte des Pfeils ausgehend gezeichnet.

Hinweis

Wenn die Option Am Raster fangen in Extras > Optionen > LibreOffice Impress > 
Raster aktiviert wurde, hat das Drücken-Halten der STRG-Taste beim Zeichnen einer 
Linie oder eines Pfeils den gegenteiligen Effekt und verhindert, dass die Linie oder der 
Pfeil am nächstgelegenen Rasterpunkt ausgerichtet wird.

Objekte gruppieren

Dieser Abschnitt gibt nur eine kurze Einführung in die Gruppierung von Objekten. Ein Beispiel für 
die Gruppierung von zwei Objekten ist in Abbildung 20 zu sehen. Weitere Informationen zur Arbeit 
mit gruppierten Objekten finden Sie im 
Handbuch Draw Kapitel 5 - Arbeiten mit mehreren Objekten

Das Gruppieren von Objekten ist vergleichbar mit dem Platzieren von Objekten in einem Contai-
ner. Die Objekte innerhalb einer Gruppe werden zusammen als ein Objekt verschoben und alle 
vorgenommenen Änderungen werden global auf die Objekte innerhalb der Gruppe angewendet. 
Eine Gruppe kann immer rückgängig gemacht werden und die Objekte, aus denen die Gruppe 
besteht, können immer separat bearbeitet werden.

Temporäre Gruppierung

Hinweis

KLICKEN-HALTEN-ZIEHEN um auszuwählen bedeutet, beginnen Sie beispielsweise links 
und oberhalb eines Objektes und beenden rechts und unterhalb eines Objektes mit 
loslassen. Dabei müssen die auszuwählenden Objekte komplett umschlossen werden. 
Dies wird auch Gummizug genannt.

Eine temporäre Gruppierung liegt vor, wenn mehrere Objekte gemeinsam ausgewählt werden. Alle 
Änderungen an den Objekten werden auf alle Objekte innerhalb der temporären Gruppe angewen-
det. Eine temporäre Gruppe von Objekten kann zum Beispiel in ihrer Gesamtheit gedreht werden.

Eine temporäre Gruppierung wird mit einer der folgenden Methoden erstellt:

• Halten Sie die UMSCHALT-Taste gedrückt, während Sie mehrere Objekte auf einer Folie 
ANKLICKEN.

• KLICKEN -halten-ziehen Sie, um einen Rahmen um mehrere Objekte zu erstellen. Lassen 
Sie die MAUSTASTE los und alle Objekte innerhalb des Rahmens sind ausgewählt.

Um eine temporäre Gruppierung von Objekten aufzuheben, KLICKEN Sie einfach außerhalb der 
Auswahlgriffe, die um die Objekte herum angezeigt werden oder drücken Sie die Taste ESC.
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Abbildung 20: Beispiel: Zwei von drei Objekten 
sind verbunden

Dauerhafte Gruppierung

1. Objekte werden mit einer der folgenden Methoden gruppiert:

○ Halten Sie die UMSCHALT-Taste gedrückt, während Sie mehrere Objekte auf einer Folie 
ANKLICKEN.

○ KLICKEN-HALTEN-ZIEHEN Sie, um einen Rahmen um mehrere Objekte zu erstellen. 
Lassen Sie die MAUSTASTE los und alle Objekte innerhalb des Rahmens sind 
ausgewählt.

○ Um alle Objekte auf der Folie auszuwählen, wählen Sie im Menü Bearbeiten > Alles 
auswählen oder verwenden Sie das Tastaturkürzel STRG+A.

2. Wenn die Ziehpunkte angezeigt werden, verwenden Sie eine der folgenden Methoden, um 
eine Gruppe ausgewählter Objekte zu erstellen:

○ Wählen Sie Format > Gruppierung > Gruppieren im Menü.

○ Verwenden Sie das Tastaturkürzel STRG+UMSCHALT+G.

○ KLICKEN Sie mit der rechten Maustaste auf ein Objekt innerhalb der ausgewählten 
Gruppe und wählen Sie im Kontextmenü Gruppieren.

Bearbeiten oder Formatieren von Gruppierungen

1. KLICKEN Sie auf ein Objekt in der Gruppe, um die Gruppe auszuwählen. Eine Bearbeitung 
oder Formatierung kann dann für alle Objekte der Gruppe oder für einzelne Objekte inner-
halb der Gruppe vorgenommen werden.

2. Um ein einzelnes Objekt innerhalb einer Gruppe zu bearbeiten, geben Sie in die Gruppe 
mit einer der folgenden Methoden:

○ Verwenden Sie das Tastaturkürzel F3.

○ Gehen Sie im Menü zu Format > Gruppierung > Betreten.

○ KLICKEN Sie mit der rechten Maustaste und wählen Sie Betreten aus dem 
Kontextmenü.
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3. Nachdem Sie eine Gruppe betreten haben, wählen Sie einzelne Objekte innerhalb der 
Gruppe zur Bearbeitung oder Formatierung aus. Ein Beispiel für die Bearbeitung einzelner 
Objekte in einer Gruppe ist in Abbildung 21 dargestellt.

4. Wenn die Bearbeitung oder Formatierung abgeschlossen ist, verwenden Sie eine der 
folgenden Methoden, um die Gruppe zu verlassen und die gesamte Gruppe wird wieder 
ausgewählt:

○ Verwenden Sie das Tastaturkürzel STRG+F3.

○ Gehen Sie im Menü zu Format > Gruppierung > Verlassen.

○ KLICKEN Sie mit der rechten Maustaste und wählen Sie Verlassen aus dem 
Kontextmenü.

Aufheben (Gruppierung)

1. KLICKEN Sie auf eines der Objekte in der Gruppe, um die Gruppierung auszuwählen.

2. Verwenden Sie bei angezeigten Ziehpunkten eine der folgenden Methoden, um die 
Gruppierung einer Gruppe von Objekten aufzuheben:

○ Wählen Sie im Menü Format > Gruppierung > Aufheben.

○ Verwenden Sie das Tastaturkürzel STRG+ALT+UMSCHALT+G.

○ KLICKEN Sie mit der rechten Maustaste auf die Gruppe und wählen Sie Aufheben aus 
dem Kontextmenü.

Tipp

Wenn die Befehle zum Gruppieren und Aufheben der Gruppierung oder andere 
Befehle regelmäßig verwendet werden, können diese Befehle zu einer Symbolleiste 
hinzugefügt werden, so dass sie sofort verfügbar sind. Weitere Informationen zum 
Anpassen der Benutzeroberfläche finden Sie in: 
Impress Kapitel 11 - Impress Anpassen und in Impress Anhang B – Symbolleisten.
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Abbildung 21: Beispiel: Die Gruppe wurde Betreten 
und ein Objekt wird bearbeitet
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Position und Größe von Grafikobjekten
Die Position und Größe von Grafikobjekten kann durch KLICKEN-HALTEN-ZIEHEN, über den Dialog Position 
und Größe oder über die Seitenleiste bei Eigenschaften verändert werden.

Positionierung

1. KLICKEN Sie auf ein Objekt oder eine Gruppe von Objekten, um die Ziehpunkte 
anzuzeigen.

2. Bewegen Sie den Cursor über ein ausgewähltes grafisches Objekt, bis der Cursor seine 
Form ändert. Die Form des Cursors hängt von den Computereinstellungen und dem 
Betriebssystem ab.

3. KLICKEN-HALTEN-ZIEHEN Sie das Objekt an die gewünschte Position. Während der 
Bewegung wird eine halbtransparente Vorschau des Objekts angezeigt, das bei der 
Neupositionierung hilft (Abbildung 22).

4. Lassen Sie die MAUSTASTE los, wenn sich das Objekt an der gewünschten Position 
befindet.

Hinweis

Die PFEIL-Tasten können auch verwendet werden, um ein ausgewähltes Objekt oder 
eine Gruppe schnell an eine neue Position zu verschieben. Mit ALT+PFEIL-Tasten 
werden kleine Bewegungsstufen erreicht.

Abbildung 22: Beispiel: Objekt positionieren 
(verschieben) – mit benutzerdefiniertem 
Cursor in Windows 10

Größenänderung

1. KLICKEN Sie auf ein Objekt oder eine Gruppe von Objekten, um die Ziehpunkte 
anzuzeigen.

2. Bewegen Sie den Cursor über einen Ziehpunkt.

3. KLICKEN-HALTEN-ZIEHEN Sie den Ziehpunkt, um die Größe des Grafikobjekts zu ändern. 
Während der Größenänderung wird eine halbtransparente Vorschau des Objekts 
angezeigt, das bei der Größenänderung hilft (Abbildung 23).

4. Um das Verhältnis zwischen Breite und Höhe beizubehalten, halten Sie die UMSCHALT-
Taste gedrückt, bevor Sie auf einen Ziehpunkt KLICKEN und ihn ziehen. Vergessen Sie 
nicht, die MAUSTASTE loszulassen, bevor Sie die UMSCHALT-Taste loslassen.
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5. Lassen Sie die UMSCHALT-Taste erst los, wenn das Objekt die gewünschte Größe erreicht 
hat.

Abbildung 23: Beispiel: 
Größenänderung eines Objekts

Dialog „Position und Größe‟

Positionierung

Um ein Grafikobjekt auf eine genaue Position auf einer Folie zu platzieren, verwenden Sie den 
Dialog Position und Größe (Abbildung 24) wie folgt:

1. Wählen Sie ein Objekt aus, um die Ziehpunkte anzuzeigen und öffnen Sie den Dialog 
Position und Größe mit einer der folgenden Methoden:

○ Verwenden Sie das Tastaturkürzel F4.

○ Wählen Sie Format > Textfeld und Form > Position und Größe im Menü.

○ KLICKEN Sie mit der rechten Maustaste auf das ausgewählte Objekt und wählen Sie im 
Kontextmenü Position und Größe.

○ KLICKEN Sie in der Seitenleiste bei Eigenschaften auf Weitere Optionen rechts neben 
der Titelleiste des Bereichs Position und Größe.

2. KLICKEN Sie auf den Tab Position und Größe um ihn anzuzeigen.

3. Geben Sie im Bereich Position die Position X (horizontal) und die Position Y (vertikal) des 
Objekts an. Die Werte geben den Abstand zum ausgewählten Basispunkt an. Die 
Standardeinstellung für den Basispunkt ist relativ zur linken oberen Ecke der Folie.

4. Wählen Sie bei Bedarf im Bereich Schützen des Dialogs die Option Position, um zu verhin-
dern, dass das Objekt neu positioniert wird. Damit wird auch automatisch die Größe 
geschützt. Nur der Schutz der Größe kann separat gewählt werden.

5. KLICKEN Sie auf OK , um die Änderungen zu speichern und den Dialog zu schließen.

Hinweis

Die Maßeinheiten, die in diesem Dialog und anderen Impress-Dialogen verwendet 
werden, werden unter Extras > Optionen > LibreOffice Impress > Allgemein einge-
stellt (Abbildung 25).
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Abbildung 24: Dialog „Position und Größe‟ – Tab „Position und Größe‟

Abbildung 25: 
Maßeinheiten

Größenänderung

1. Wählen Sie ein Objekt aus, um die Ziehpunkte anzuzeigen und öffnen Sie den Dialog 
Position und Größe mit einer der folgenden Methoden:

○ Verwenden Sie das Tastaturkürzel F4.

○ Wählen Sie Format > Textfeld und Form > Position und Größe im Menü.

○ KLICKEN Sie mit der rechten Maustaste auf das ausgewählte Objekt und wählen Sie im 
Kontextmenü Position und Größe.
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○ KLICKEN Sie in der Seitenleiste bei Eigenschaften auf Weitere Optionen rechts neben 
der Titelleiste des Bereichs Position und Größe, Abbildung 26.

2. KLICKEN Sie auf den Tab Position und Größe, um ihn anzuzeigen.

3. Wählen Sie unter Größe einen Basispunkt aus, der bei der Größenänderung des Objekts 
als Anker verwendet werden soll. Die Standardauswahl Linke obere Ecke bedeutet, dass 
die linke obere Ecke des Objekts bei einer Größenänderung ihre Position nicht ändert.

4. Um das Seitenverhältnis zwischen Breite und Höhe beizubehalten, wählen Sie im Bereich 
Größe die Option Seitenverhältnis beibehalten, bevor Sie die Breite oder Höhe ändern. 
Wenn die Option Seitenverhältnis beibehalten aktiviert ist, wird bei einer Änderung des 
Wertes einer Dimension automatisch die andere Dimension geändert, wobei das Seitenver-
hältnis zwischen Objektbreite und -höhe beibehalten wird.

5. Um die Breite oder Höhe des Objekts unabhängig voneinander festzulegen, vergewissern 
Sie sich, dass die Option Seitenverhältnis beibehalten nicht aktiviert ist und geben Sie dann 
im Bereich Größe einen Wert für die Breite und/oder Höhe des Objekts ein.

6. Aktivieren Sie ggf. im Bereich Schützen die Option Größe, um zu verhindern, dass das 
Objekt in der Größe verändert wird.

7. KLICKEN Sie auf OK , um die Änderungen zu speichern und den Dialog zu schließen.

Seitenleiste Bereich „Position und Größe‟

Verwenden Sie den Bereich Position und Größe in der Seitenleiste bei Eigenschaften 
(Abbildung 26), um ein Grafikobjekt zu positionieren und seine Größe zu ändern.

Abbildung 26: Seitenleiste „Eigenschaften‟ - 
„Position und Größe‟
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Positionierung

1. Wählen Sie ein Objekt aus, um die Ziehpunkte anzuzeigen.

2. KLICKEN Sie in der Seitenleiste auf Eigenschaften, um die Eigenschaften zu öffnen.

3. KLICKEN Sie auf das Pluszeichen +  bei Position und Größe, um den Bereich zu öffnen.

4. Geben Sie die Position X (horizontal) und die Position Y (vertikal) des Objekts an. Die 
Werte stellen den Abstand zum ausgewählten Basispunkt im Dialog Position und Größe 
dar.

5. Drücken Sie die EINGABE-Taste, um die Änderungen zu übernehmen.

Größenänderung

1. Wählen Sie ein Objekt aus, um die Ziehpunkte anzuzeigen.

2. KLICKEN Sie in der Seitenleiste auf Eigenschaften, um die Eigenschaften zu öffnen.

3. KLICKEN Sie auf das Pluszeichen +  bei Position und Größe, um den Bereich zu öffnen. 
Um das Seitenverhältnis zwischen Breite und Höhe beizubehalten, wählen Sie die Option 
Seitenverhältnis beibehalten, bevor Sie die Breite oder Höhe ändern. Wenn die Option 
Seitenverhältnis beibehalten aktiviert ist, wird beim Ändern des Wertes einer Größe 
automatisch die andere Größe geändert, wobei das Verhältnis zwischen Objektbreite und 
-höhe beibehalten wird.

4. Um die Breite oder Höhe des Objekts unabhängig voneinander festzulegen, vergewissern 
Sie sich, dass die Option Seitenverhältnis beibehalten nicht aktiviert ist und geben Sie dann 
einen Wert für die Breite und/oder Höhe des Objekts ein.

5. Drücken Sie die EINGABE-Taste, um die Änderungen vorzunehmen.

Spezialeffekte anwenden

Neben den grundlegenden Aktionen zum Verschieben und Ändern der Größe eines Objekts 
können in Impress auch eine Reihe von Spezialeffekten auf Objekte angewendet werden. In 
diesem Abschnitt wird beschrieben, wie ein Objekt gedreht, gespiegelt und verzerrt werden kann.

Drehen grafischer Objekte

Schnelles Drehen

1. Wählen Sie ein Objekt aus, um die Ziehpunkte anzuzeigen.

2. KLICKEN Sie in der Symbolleiste Linie und Füllung (Abbildung 27) auf das Dreieck  neben 
Verändern und dann auf Drehen in der Symbolleiste Verändern, Abbildung 28. Die 
Ziehpunkte ändern ihre Form und Farbe, wie im Beispiel in Abbildung 29 gezeigt. In der 
Mitte des Objekts erscheint außerdem ein Drehpunkt, der das Drehzentrum angibt.

3. Bewegen Sie den Mauszeiger über einen der Eck-Ziehpunkte und der Mauszeiger ändert 
seine Form und zeigt die Bewegungsrichtung an.

4. KLICKEN Sie auf einen Eck-Ziehpunkt, halten Sie die MAUSTASTE gedrückt und bewegen 
Sie das Objekt in die gewünschte Richtung, um es zu drehen. Nur die Eck-Ziehpunkte sind 
für die Drehung aktiv.

5. Wenn Sie mit der Drehung zufrieden sind, lassen Sie die MAUSTASTE los.

6. Um das Drehzentrum des Objekts zu ändern, KLICKEN Sie auf den Drehpunkt in der Mitte, 
halten Sie ihn gedrückt und ziehen Sie ihn in die gewünschte Position. Der Drehpunkt kann 
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an eine beliebige Stelle auf der Folie verschoben werden, auch außerhalb der 
Objektgrenzen.

7. Um die Drehwinkel auf das Vielfache von 15° zu beschränken, halten Sie die UMSCHALT-
Taste gedrückt, während Sie das Objekt drehen. Dies ist nützlich, um Bilder um einen 
rechten Winkel zu drehen, zum Beispiel vom Hoch- ins Querformat. Lassen Sie zuerst die 
MAUSTASTE los und dann die UMSCHALT-Taste.

Abbildung 27: Symbolleiste „Linie und Füllung‟

1 Position und Größe

2 Objekte ausrichten

3 Ganz nach vorn

4 Weiter nach vorn

5 Weiter nach hinten

6 Ganz nach hinten

7 Vor das Objekt

8 Hinter das Objekt

9 Vertauschen

10 Linienstil

11 Linienbreite

12 Linienfarbe

13 Flächenstil/-füllung

14+15 Füllfarbe

16 Schatten

17 Linienspitzen

18 Vertikal Spiegeln

19 Horizontal Spiegeln

20 Verändern, (s. Abb. 28)

21 Interaktion

22 Formatvorlagen anzeigen

23 Raster anzeigen

24 Am Raster fangen

25 Hilfslinien beim Verschieb.

Abbildung 28: Symbolleiste 
„Verändern‟

1 Drehen

2 Spiegeln

3 In 3D Rotationskörper

4 In Kreis setzen

5 Auf Kreis setzen

6 Verzerren

7 Interaktives Transparenz Werkzeug

8 Interaktives Farbverlauf Werkzeug
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Abbildung 29: links: Objekt angewählt
rechts: Objekt mit farbigen Ziehpunkten und Drehpunkt in der Mitte

Dialog „Position und Größe - Drehung‟

Anstatt ein Objekt manuell zu drehen, können Sie den Tab Drehung des Dialogs Position und 
Größe (Abbildung 31) verwenden, um ein Objekt genau zu drehen.

1. Wählen Sie ein Objekt aus, um die Ziehpunkte anzuzeigen und öffnen Sie dann den Dialog 
Position und Größe mit einer der folgenden Methoden:

○ Verwenden Sie das Tastaturkürzel F4.

○ Wählen Sie Format > Textfeld und Form > Position und Größe im Menü.

○ KLICKEN Sie mit der rechten Maustaste auf das ausgewählte Objekt und wählen Sie im 
Kontextmenü Position und Größe.

○ KLICKEN Sie auf Weitere Optionen auf der rechten Seite des Bereichs Position und 
Größe in der Seitenleiste bei Eigenschaften.

2. KLICKEN Sie auf den Tab Drehung, um ihn anzuzeigen.

3. Geben Sie bei Drehpunkt einen gewünschten Wert für Position X und Position Y ein, um 
die Position des Drehpunkts zu verschieben. Die Standardposition des Drehpunkts ist die 
Mitte des Objekts. Alternativ können Sie einen Drehpunkt aus einer der 9 Positionen von 
den Voreinstellungen auswählen.

4. Geben Sie unter Drehwinkel den Grad der Drehung in das Textfeld Winkel 
ein. Alternativ dazu können Sie auf den Drehwinkelanzeiger (Abbildung 30) 
KLICKEN und ihn auf einen neuen Winkel ziehen. Der Winkel der Drehung 
wird im Auswahl-Feld Winkel angezeigt.

5. KLICKEN Sie auf OK , um die Änderungen zu speichern und den Dialog zu 
schließen.
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Abbildung 31: Dialog „Position und Größe‟ - Tab „Drehung‟

Drehung in der Seitenleiste

Verwenden Sie den Bereich Position und Größe  in der Seitenleiste (Abbildung 26 oben 
auf Seite 26), um ein Objekt wie folgt zu drehen:

1. Wählen Sie ein Objekt aus, um die Ziehpunkte anzuzeigen.

2. KLICKEN Sie in der Seitenleiste auf Eigenschaften, um sie zu öffnen.

3. KLICKEN Sie auf das Pluszeichen +  bei Position und Größe, um den Bereich zu öffnen.

4. Geben Sie unter Drehung den Grad der Drehung in das Auswahl-Feld ein oder KLICKEN Sie 
auf den Drehwinkelanzeiger und ziehen Sie ihn auf einen neuen Winkel. Der Drehwinkel 
wird im Auswahl-Feld Drehung angezeigt.

5. Drücken Sie die EINGABE-Taste, um die Änderungen vorzunehmen.

Objekte spiegeln

Schnelles Spiegeln

1. KLICKEN Sie auf ein Objekt, um die Ziehpunkte anzuzeigen.

2. Spiegeln Sie ein ausgewähltes Objekt, indem Sie eine der folgenden Methoden verwenden:

○ KLICKEN Sie mit der rechten Maustaste auf das ausgewählte Objekt und wählen Sie im 
Kontextmenü Spiegeln > Vertikal oder > Horizontal.
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○ KLICKEN Sie in der Symbolleiste Linie und Füllung auf das Symbol Vertikal oder 
Horizontal spiegeln.

○ Gehen Sie im Menü zu Spiegeln > Vertikal oder > Horizontal.

○ KLICKEN Sie in der Seitenleiste bei Eigenschaften im Bereich Position und Größe auf 
Vertikal spiegeln oder Horizontal spiegeln (Abbildung 26 oben auf Seite 26).

Symbol „Spiegeln‟

Um die Position und den Winkel zu ändern, in dem ein Objekt gespiegelt wird, wird das Symbol 
Spiegeln in der Symbolleiste Verändern (Abbildung 28) verwendet, wie in dem Beispiel in Abbil-
dung 32 gezeigt.

1. KLICKEN Sie auf ein Objekt, um die Ziehpunkte anzuzeigen.

2. Gehen Sie zu Ansicht > Symbolleisten > Verändern, um die Symbolleiste Verändern zu 
öffnen.

3. KLICKEN Sie in der Symbolleiste Verändern auf Spiegeln. Daraufhin wird eine Symmetrie-
achse als gestrichelte Linie durch die Mitte des Objekts angezeigt 
(Punkt 1) in Abbildung 32). Das Objekt wird um diese Symmetrieachse gespiegelt.

4. KLICKEN Sie auf die Symmetrieachse und ziehen Sie sie an eine neue Position oder positi-
onieren Sie den Cursor in einem der Punkte, die sich am Ende der Symmetrieachse befin-
den und ziehen Sie mit dem Cursor, um den Winkel zu ändern (Punkt 2) in Abbildung 32).

5. Setzen Sie den Cursor auf einen der Ziehpunkte für das Objekt.

6. KLICKEN-HALTEN-ZIEHEN Sie den Cursor über die Symmetrieachse, um das Objekt zu 
spiegeln. Beim Ziehen des Objekts wird während des Verlaufs jeweils die neue Position als 
eine halbtransparente Vorschau angezeigt (Punkt 3) in Abbildung 32), bis Sie die 
MAUSTASTE loslassen.

7. Lassen Sie den Cursor los und das Objekt erscheint gespiegelt zur Symmetrieachse. 
Winkel und Position der Drehung hängen vom Winkel und der Position der Symmetrie-
achse ab (Punkt 4) in Abbildung 32).

Abbildung 32: Beispiel: Anwenden des Symbols „Spiegeln‟ in der Symbolleiste „Verändern‟

Hinweis

Halten Sie die UMSCHALT-Taste gedrückt, während Sie die Symmetrieachse bewegen, 
um sie in 45°-Schritten zu drehen.
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Spiegelbildliche Kopien

Die Spiegelung eines Objekts kann mittels erstellen einer Objektkopie erfolgen:

1. Wählen Sie das zu spiegelnde Objekt aus und kopieren Sie es in die Zwischenablage.

2. Drehen Sie das Objekt mit einer der Methoden unter „Schnelles Drehen‟ und verschieben 
Sie das gedrehte Objekt auf eine Folie.

3. KLICKEN Sie in einen leeren Bereich der Folie, um die Auswahl des Objekts aufzuheben.

4. Fügen Sie das kopierte Objekt aus der Zwischenablage in die Folie ein.

5. Markieren Sie beide Objekte, KLICKEN Sie dann mit der rechten Maustaste und wählen Sie 
im Kontextmenü die Option Ausrichtung.

6. Wählen Sie die gewünschte Art der Ausrichtung. Oben, Zentriert oder Unten, wenn eine 
horizontale Spiegelkopie erstellt werden soll. Links, Zentriert oder Rechts, wenn eine verti-
kale Spiegelkopie erstellt werden soll.

Bilder verzerren

Drei Symbole in der Symbolleiste Verändern ermöglichen die Verzerrung eines Objekts.

1. Verzerren - verzerrt ein Objekt in der Perspektive.

2. In Kreis setzen (schräg) - erzeugt einen Pseudo-3D-Effekt.

3. Auf Kreis setzen (Perspektive) - erzeugt einen Pseudo-3D-Effekt.

Siehe Abbildung 33

Hinweis

Wenn Sie diese Symbole verwenden, werden Sie gefragt, ob das Objekt vor dem 
Verzerren in eine Kurve umgewandelt werden soll. Die Umwandlung eines Objekts in 
eine Kurve kann nicht rückgängig gemacht werden beziehungsweise nur mit der 
Funktion Rückgängig.
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Abbildung 33: Beispiele: Verzerren, In Kreis setzen, Auf Kreis setzen – mit Kreis ist hier nicht das 
Objekt, sondern die Verzerrungform gemeint

Symbol „Verzerren‟

Beispiele für die Verzerrung eines Objekts in den Ecken, in der Vertikalen und in der Horizontalen 
mit dem Symbol Verzerren sind in Abbildung 34 dargestellt.

1. Wählen Sie ein Objekt aus und KLICKEN Sie in der Symbolleiste Verändern auf Verzerren.

2. KLICKEN Sie auf Ja , um das Objekt in eine Kurve umzuwandeln. Wenn das Objekt bereits 
eine Kurve ist, wird dieser Dialog nicht angezeigt.

Abbildung 34: Verzerrung eines Objekts in den Ecken

1) Original Form 2) Eckenverzerrung 3) Vertikale Verzerrung 4) Horizontale 
Verzerrung

3. KLICKEN-HALTEN-ZIEHEN Sie einen Eckziehpunkt, um das Objekt zu verzerren, wobei der 
gegenüberliegende Eckziehpunkt als Ankerpunkt für die Verzerrung dient.

4. KLICKEN-HALTEN-ZIEHEN Sie die vertikalen Ziehpunkte, um das Objekt zu verzerren, indem 
Sie die gegenüberliegende vertikale Seite als Ankerpunkt für die Verzerrung verwenden.
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5. KLICKEN-HALTEN-ZIEHEN Sie die horizontalen Ziehpunkte, um das Objekt zu verzerren und 
die gegenüberliegende horizontale Seite als Ankerpunkt für die Verzerrung zu verwenden.

Symbol „In Kreis setzen‟

Abbildung 35 zeigt ein Beispiel für die Verzerrung eines Objekts mit dem Symbol In Kreis setzen 
(Perspektive).

1. Wählen Sie ein Objekt aus und KLICKEN Sie in der Symbolleiste Verändern auf In Kreis 
setzen (Perspektive).

2. KLICKEN Sie auf Ja , um das Objekt in eine Kurve umzuwandeln. Wenn das Objekt bereits 
eine Kurve ist, wird dieser Dialog nicht angezeigt.

3. KLICKEN Sie auf einen der Ziehpunkte und ziehen Sie ihn, um eine Pseudo-3D-Perspektive 
zu erzeugen, indem Sie die gegenüberliegende Seite als Ankerpunkt verwenden. Während 
das Objekt verzerrt wird, erscheint eine halbtransparente Vorschau, die einen Hinweis 
darauf gibt, wie das resultierende Objekt aussehen wird.

Abbildung 35: Beispiel: 
links: Original   |   rechts: In Kreis setzen (Perspektive)

Symbol „Auf Kreis setzen‟

Abbildung 36 zeigt ein Beispiel für die Verzerrung eines Objekts mit dem Symbol Auf Kreis setzen 
(schräg).

1. Wählen Sie ein Objekt aus und KLICKEN Sie in der Symbolleiste Verändern auf Auf Kreis  
setzen (schräg).

2. KLICKEN Sie auf Ja , um das Objekt in eine Kurve umzuwandeln. Wenn das Objekt bereits 
eine Kurve ist, wird dieser Dialog nicht angezeigt.

3. KLICKEN Sie auf einen der Ziehpunkte und ziehen Sie ihn, um eine Pseudo-3D-Perspektive 
zu erzeugen, indem Sie die gegenüberliegende Seite als Ankerpunkt verwenden. Während 
das Objekt verzerrt wird, erscheint eine halbtransparente Vorschau, die einen Hinweis 
darauf gibt, wie das resultierende Objekt aussehen wird.
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Abbildung 36: Beispiel: 
links: Original   |   rechts: Auf Kreis setzen (schräg)

Objekte ausrichten

Verwenden Sie die Ausrichtungs-Symbole von LibreOffice in der Symbolleiste (Abbildung 37), um 
die relative Position eines Objekts im Vergleich zu einem anderen Objekt anzupassen. Diese 
Ausrichtungs-Symbole sind nur aktiv, wenn zwei oder mehr Objekte ausgewählt sind. Die Ausrich-
tungsoptionen sind wie folgt:

• Links, Zentriert, Rechts - bestimmt die horizontale Ausrichtung der ausgewählten Objekte.

• Oben, Mitte, Unten - bestimmt die vertikale Ausrichtung der ausgewählten Objekte.

Wählen Sie zwei oder mehr Objekte zum Ausrichten aus und verwenden Sie eine der folgenden 
Methoden, um auf die Ausrichtungsoptionen zuzugreifen:

• KLICKEN Sie auf das Dreieck  neben Objekte ausrichten in der Symbolleiste Linie und 
Füllung. Wählen Sie eine Ausrichtungsoption aus den verfügbaren Symbolen aus. Das 
angezeigte Symbol Objekte ausrichten in der Symbolleiste Linie und Füllung hängt von 
dem zuletzt verwendeten Symbol ab.

• Gehen Sie im Menü auf Ansicht > Symbolleisten > Objekte ausrichten, um die Symbol-
leiste Objekte ausrichten zu öffnen. Wählen Sie eine Ausrichtungsoption aus den verfügba-
ren Symbolen aus.

• KLICKEN Sie mit der rechten Maustaste auf die Gruppe der ausgewählten Objekte und 
wählen Sie Objekte ausrichten und dann eine der Ausrichtungsoptionen aus dem 
Kontextmenü.

Abbildung 37: Symbolleiste 
„Objekte ausrichten‟

1 Links

2 Zentriert

3 Rechts

4 Oben

5 Mitte

6 Unten
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Raster- oder Fangfunktionen verwenden

In Impress können Objekte mithilfe von Rasterpunkten, Fangpunkten und -linien, Objektrahmen, 
einzelnen Punkten auf Objekten oder Seitenkanten genau und deckend positioniert werden. Diese 
Funktion wird als Fangen bezeichnet und ermöglicht die Positionierung eines Objekts an genau 
derselben Stelle auf mehreren Folien.

Die Bearbeitung mit Fangfunktionen wird mit dem höchsten praktischen Zoomwert für eine Präsen-
tation vereinfacht. Es können zwei verschiedene Fangfunktionen gleichzeitig verwendet werden, 
zum Beispiel das Fangen an einer Hilfslinie und am Folienrand. Es wird empfohlen, nur solche 
Fangfunktionen zu aktivieren, die auch benötigt werden.

Einrichten von Raster und Fangen

Um das Raster und das Fangen in einer Präsentation einzurichten, gehen Sie im Menü auf Extras 
> Optionen > LibreOffice Impress > Raster, um den Dialog Raster anzuzeigen (Abbildung 38).

Abbildung 38: Dialog „Optionen - LibreOffice Impress - Raster‟

Raster

Legt die Einstellungen für das in Impress verwendete Raster fest. Dieses Raster hilft bei der 
Einstellung der genauen Position von Objekten. Außerdem kann das Raster in Übereinstimmung 
mit Am Raster fangen eingestellt werden. Wenn Raster aktiviert ist, halten Sie die UMSCHALT-Taste 
gedrückt, um einzelne Objekte ohne am Raster zu fangen, zu verschieben oder zu erstellen.
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Am Raster fangen

Legt fest, wie Rahmen, Zeichenelemente und Steuerelemente zwischen Rasterpunkten 
verschoben werden. Um den Status von Am Raster ausrichten nur für die aktuelle Aktion zu 
ändern, ziehen Sie ein Objekt bei gedrückter STRG-Taste.

Raster sichtbar

Gibt an, ob das Raster angezeigt wird.

Auflösung

Horizontal

Legt den Abstand der Rasterpunkte in der vorhandenen Maßeinheit auf der X-Achse fest.

Vertikal

Legt den Abstand der Rasterpunkte in der vorhandenen Maßeinheit auf der Y-Achse fest.

Unterteilung

Horizontal

Geben Sie die Anzahl der Schritte zwischen den Rasterpunkten auf der X-Achse an.

Vertikal

Geben Sie die Anzahl der Schritte zwischen den Rasterpunkten auf der Y-Achse an.

Achsen synchronisieren

Gibt an, dass die aktuellen Rastereinstellungen symmetrisch geändert werden. Die Auflösung 
und Unterteilung für die X- und Y-Achse bleiben dann gleich.

Fangen

An Fanglinien fangen

Fängt die Kante eines gezogenen Objekts an der nächstgelegenen Fanglinie, wenn die 
MAUSTASTE losgelassen wird. Diese Einstellung kann auch über die Option An Fanglinien 
fangen in der Symbolleiste Optionen definiert werden (Abbildung 39).

An den Seitenrändern

Legt die Ausrichtung eines grafischen Objekts auf den nächstgelegenen Seitenrand fest. Der 
Cursor oder eine Umrisslinie des Objekts muss sich im Fangbereich befinden. In einer Präsen-
tation kann diese Funktion auch mit An Seitenrändern fangen in der Symbolleiste Optionen 
aufgerufen werden.

Am Objektrahmen

Legt die Ausrichtung eines grafischen Objekts an der Grenze des nächstgelegenen Objekts fest. 
Der Cursor oder eine Umrisslinie des Objekts muss sich im Fangbereich befinden. In einer Präsen-
tation kann diese Funktion auch mit Am Objektrahmen fangen in der Symbolleiste Optionen aufge-
rufen werden.

An Objektpunkten

Legt die Ausrichtung eines grafischen Objekts an den Punkten des nächstgelegenen Objekts 
fest. Dies gilt nur, wenn sich der Cursor oder eine Umrisslinie des Objekts im Fangbereich 
befindet. In einer Präsentation kann diese Funktion auch mit An Objektpunkten fangen in der 
Symbolleiste Optionen aufgerufen werden.
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Abbildung 39: Symbolleiste „Optionen‟

1 Drehmodus

2 Raster anzeigen

3 Fanglinien sichtbar

4 Hilfslinien beim Verschieben

5 Am Raster fangen

6 An Fanglinien fangen

7 An Seitenrändern fangen

8 Am Objektrahmen fangen

9 An Objektpunkten fangen

10 Schnellbearbeitung zulassen

11 Nur Textbereich auswählen

12 Text bearbeiten mit Doppelklick

13 Objekt mit Attributen ändern

14 Alle Gruppierungen verlassen

Fangbereich

Legt den Fangabstand zwischen dem Cursor und dem Objektumriss fest. Es wird auf einen 
Fangpunkt gefangen, wenn der Cursor näher als der gewählte Abstand ist.

Objekte beschränken

Beim Erzeugen und bewegen

Legt fest, dass Objekte beim Erstellen oder Verschieben vertikal, horizontal oder diagonal 
(45°) eingeschränkt werden. Diese Einstellung kann durch Drücken und Halten der UMSCHALT-
Taste vorübergehend deaktiviert werden.

Längere Kantenlänge

Legt fest, dass ein Quadrat auf der Grundlage der längeren Seite eines Rechtecks erstellt 
wird, wenn die UMSCHALT-Taste gedrückt wird, bevor der Cursor losgelassen wird. Dies gilt 
auch für eine Ellipse (ein Kreis wird auf der Grundlage des längsten Durchmessers der Ellipse 
erstellt). Wenn Längere Kantenlänge nicht ausgewählt ist, wird ein Quadrat oder ein Kreis auf 
der Grundlage der kürzeren Seite oder des Durchmessers erstellt.

Beim Drehen

Legt fest, dass Objekte nur innerhalb des ausgewählten Drehwinkels gedreht werden können. 
Um ein Objekt außerhalb des festgelegten Winkels zu drehen, drücken Sie beim Drehen die 
UMSCHALT-Taste. Lassen Sie die UMSCHALT-Taste los, wenn der gewünschte Drehwinkel 
erreicht ist.

Punktreduktion

Legt den Winkel für die Punktreduzierung fest. Bei der Arbeit mit Polygonen ist dies nützlich, 
um die Bearbeitungspunkte zu reduzieren.

Die Raster- und Fangfunktionen können auch mit einer der folgenden Methoden angezeigt und 
ein- oder ausgeschaltet werden:

• Gehen Sie im Menü auf Extras > Optionen > LibreOffice Impress > Raster, um den 
Dialog Raster anzuzeigen.

• KLICKEN Sie mit der rechten Maustaste auf eine Folie und verwenden Sie die Optionen im 
Kontextmenü.

• Verwendung Sie die Symbole in der Symbolleiste Optionen.
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Am Raster fangen

Am Raster fangen verwenden

Verwenden Sie die Funktion Am Raster fangen, um ein Objekt genau auf einen Rasterpunkt in 
einer Folie zu verschieben. Diese Funktion kann auf eine der folgenden Arten ein- und ausgeschal-
tet werden:

• Wählen Sie im Menü Ansicht > Fanglinien > Am Raster fangen.

• KLICKEN Sie mit der rechten Maustaste auf eine Folie und wählen Sie im Kontextmenü 
Raster und Hilfslinien > Am Raster fangen.

• KLICKEN Sie in der Symbolleiste Optionen auf Am Raster fangen.

Raster anzeigen

Um das Raster in einer Präsentation ein- oder auszublenden, können Sie eine der folgenden 
Methoden verwenden:

• Gehen Sie im Menü zu Ansicht > Raster und Hilfslinien > Raster sichtbar.

• KLICKEN Sie in der Symbolleiste Optionen auf Raster anzeigen.

• KLICKEN Sie mit der rechten Maustaste auf eine Folie und wählen Sie im Kontextmenü 
Raster und Hilfslinien > Raster sichtbar.

• Wählen Sie die Option Raster sichtbar unter Extras > Optionen > LibreOffice Impress > 
Raster.

Die Farbe der Rasterpunkte ändern

Standardmäßig und je nach Bildschirm und Computereinstellung sind die Rasterpunkte grau und 
nicht immer leicht zu erkennen. Um die Farbe der Rasterpunkte zu ändern, gehen Sie zu Extras > 
Optionen > LibreOffice > Anwendungsfarben, um den Dialog Optionen – LibreOffice - 
Anwendungsfarben zu öffnen (Abbildung 40). Wählen Sie aus der Auswahl-Liste im Bereich Zeich-
nung / Präsentation eine geeignete Farbe für das Raster aus, damit die Rasterpunkte im 
verwendeten Farbschema besser zur Geltung kommen.
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Abbildung 40: Dialog „Optionen - LibreOffice - Anwendungsfarben‟

Fangpunkte und -linien

Im Gegensatz zum Raster können Fangpunkte und -linien für die Positionierung eines Objekts an 
einer beliebig gewünschten Stelle/Position auf einer Folie eingefügt werden. Fanglinien können 
entweder horizontal oder vertikal sein und erscheinen als gestrichelte Linien. Fangpunkte erschei-
nen als kleine Kreuze mit gestrichelten Linien. Fangpunkte und Fanglinien werden in der Druck-
ausgabe nicht angezeigt.

Einfügen von Fangpunkten und -linien

Um einen Fangpunkt oder -linie einzufügen, verwenden Sie eine der folgenden Methoden, um den 
Dialog Neues Fangobjekt zu öffnen (Abbildung 41):

• Gehen Sie im Menü auf Einfügen > Fanglinie…

• KLICKEN Sie mit der rechten Maustaste auf eine leere Stelle auf einer Folie und wählen Sie 
aus dem Kontextmenü Fanglinie > Einfügen… aus.
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Abbildung 41: Dialog „Neues Fangobjekt‟

Im Dialog Neues Fangobjekt sind folgende verfügbaren Optionen:

Position

Legt die Position eines ausgewählten Fangpunkts oder einer Linie relativ zur linken oberen Ecke 
der Folie fest.

X: - Geben Sie den erforderlichen Abstand zwischen dem Fangpunkt oder der -linie und dem 
linken Folienrand ein.

Y: - Geben Sie den erforderlichen Abstand zwischen dem Fangpunkt oder der -linie und dem 
oberen Rand der Seite ein.

Art

Gibt die Art des gewünschten Fangobjekts an.

Punkt - Fügt einen Fangpunkt ein. Die beiden Auswahlfelder X: und Y: sind aktiv.

Vertikal - Fügt eine vertikale Fanglinie ein. Nur das Auswahlfeld X: ist aktiv.

Horizontal - Fügt eine horizontale Fanglinie ein. Nur das Auswahlfeld Y: ist aktiv.

Tipp

Beim Positionieren von Fanglinien ist es hilfreich, die Lineale anzuzeigen, indem Sie 
im Menü Ansicht > Lineale (STRG+UMSCHALT+R) wählen. Mit KLICKEN-HALTEN-ZIEHEN 
bewegen Sie diese vom horizontalen oder vertikalen Lineal eine Fanglinie auf die Folie 
oder wieder zurück zum Lineal.

Fangpunkte und -linien anzeigen

Sie können Fangpunkte und -linien in einer Präsentation mit einer der folgenden Methoden 
anzeigen oder ausschalten:

• Gehen Sie im Menü zu Ansicht > Fanglinien > Fanglinien sichtbar.

• KLICKEN Sie in der Symbolleiste Optionen auf Fanglinien sichtbar.

• KLICKEN Sie mit der rechten Maustaste auf eine Folie und wählen Sie im Kontextmenü 
Fanglinien > Fanglinien sichtbar.

Fangpunkte bearbeiten

1. KLICKEN Sie mit der rechten Maustaste auf einen Fangpunkt 
und wählen Sie Fangpunkt bearbeiten aus dem Kontext-
menü (Abbildung 42), um den Dialog Fangpunkt bearbeiten 
zu öffnen (Abbildung 43).
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2. Geben Sie neue X: und Y: Koordinateneinstellungen für den Fangpunkt ein und KLICKEN 
Sie auf OK .

3. Alternativ können Sie auch auf den Fangpunkt KLICKEN und ihn an eine bestimmte Position 
auf der Folie ziehen.

Abbildung 43: Dialog „Fangpunkt bearbeiten‟

Fanglinien bearbeiten

1. KLICKEN Sie mit der rechten Maustaste auf eine Fanglinie und 
wählen Sie Fanglinie bearbeiten aus dem Kontextmenü 
(Abbildung 44), um den Dialog Fanglinie bearbeiten zu öffnen 
(Abbildung 45).

2. Geben Sie eine neue X:-Koordinateneinstellung für vertikale Fanglinien oder eine neue 
Y:-Koordinateneinstellung für horizontale Fanglinien ein und KLICKEN Sie auf OK .

3. Alternativ können Sie auch auf eine Fanglinie KLICKEN und sie an eine neue Position auf 
der Folie oder zurück ins Lineal ziehen.

Abbildung 45: Dialog „Fanglinie bearbeiten‟

Löschen von Fangpunkten und -linien

1. KLICKEN Sie mit der rechten Maustaste auf einen Fangpunkt oder eine Fanglinie.

2. Wählen Sie im Kontextmenü Fangpunkt löschen oder Fanglinie löschen, 
Abbildung 42 + 44.

Hinweis

Wenn Sie im Dialog Fangpunkt bearbeiten oder Fanglinie bearbeiten auf Löschen  
KLICKEN, wird ein Fangpunkt oder eine Fanglinie ebenfalls gelöscht.
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Fangbereich konfigurieren

Der Standardfangbereich, in dem ein Objekt an einem Fangpunkt oder einer Linie einrastet, kann 
wie folgt konfiguriert werden:

Wählen Sie Extras > Optionen > LibreOffice Impress > Raster im Menü, um den Dialog Optio-
nen - LibreOffice Impress - Raster zu öffnen.

Geben Sie in das Auswahl-Feld Fangbereich die Anzahl der Pixel ein, die um das Objekt herum 
das Einrasten er möglichen soll. Die Standardeinstellung ist 5 Pixel, Abbildung 46 mit 50 Pixel.

KLICKEN Sie auf OK , um den neuen Fangbereich festzulegen und den Dialog zu schließen.

Abbildung 46: Beispiel: Fangbereich (hier rosa, ist aber nicht 
sichtbar)

Verwendung von Hilfslinien

Hilfslinien werden zur Positionierung von Objekten und zur Anzeige verwendet, während ein Objekt 
bewegt wird. Die Hilfslinien erstrecken sich von den Kanten des Objekts bis zu den Linealen an der 
oberen und linken Seite eines Arbeitsbereichs und haben keine Fangfunktion, Abbildung 47.

Abbildung 47: Beispiel: Ansicht der 
Hilfslinien

Verwenden Sie eine der folgenden Methoden, um Hilfslinien beim Verschieben eines Objekts 
anzuzeigen:
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• Gehen Sie im Menü zu Extras > Optionen > LibreOffice Impress > Ansicht , um den 
Dialog Optionen - LibreOffice Impress - Ansicht (Abbildung 48) zu öffnen und wählen Sie 
Hilfslinien beim Bewegen.

• KLICKEN Sie in der Symbolleiste Optionen auf Hilfslinien beim Verschieben.

• KLICKEN Sie mit der rechten Maustaste in einen leeren Bereich auf einer Folie und wählen 
Sie im Kontextmenü Raster und Hilfslinien > Hilfslinien beim Verschieben.

Abbildung 48: Dialog „Optionen - LibreOffice Impress - Ansicht‟ - „Hilfslinien beim 
Bewegen‟

Anordnen von Objekten

Impress ordnet die Objekte in den Stapelebenen so an, dass die Objekte auf jeder Ebene des 
Stapels die Objekte auf den darunterliegenden Ebenen überdecken, falls es zu Überschneidungen 
kommt. Die Ebene für jedes Objekt wird durch das Anordnen auf einer Folie geändert. Wählen Sie 
ein Objekt oder mehrere Objekte aus und verwenden Sie eine der folgenden Methoden, um die 
Ebene zu ändern:

• KLICKEN Sie auf das gewünschte Anordnungs-Symbol in der Symbolleiste Linie und 
Füllung.

• KLICKEN Sie mit der rechten Maustaste auf die Objekte und wählen Sie im Kontextmenü die 
Option Anordnen und im Untermenü die gewünschte Anordnungsoption.

• Gehen Sie im Menü zu Format > Anordnen und wählen Sie eine Option aus dem 
Untermenü.
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Abbildung 49: Legende für die Anordnung von Objekten 
(Stapelebenen)

Die folgenden Optionen stehen für die Anordnung eines Objektstapels auf einer Folie zur 
Verfügung:

 Ganz nach vorn - Das ausgewählte Objekt wird vor alle anderen Objekte verschoben. Tastatur-
kürzel STRG+UMSCHALT++.

 Weiter nach vorn - Das ausgewählte Objekt wird im Stapel eine Ebene nach oben verschoben. 
Tastaturkürzel STRG++.

 Weiter nach hinten - Das ausgewählte Objekt wird im Stapel eine Ebene nach unten verscho-
ben. Tastaturkürzel STRG+-.

 Ganz nach hinten - Das ausgewählte Objekt wird hinter alle anderen Objekte verschoben. 
Tastaturkürzel STRG+UMSCHALT+-.

 Vor das Objekt - Verschiebt das erste ausgewählte Objekt vor das zweite ausgewählte Objekt. 
Wählen Sie das erste hintere Objekt aus und KLICKEN Sie auf das Symbol Vor das Objekt und 
dann auf das zweite Objekt, um die Position des ersten Objektes vor das Zweite zu stellen.

 Hinter das Objekt - Verschiebt das erste ausgewählte Objekt hinter das zweite ausgewählte 
Objekt. Wählen Sie das erste vordere Objekt aus und KLICKEN Sie auf das Symbol Hinter das 
Objekt und dann auf das zweite Objekt, um die Position des ersten Objektes hinter das Zweite zu 
stellen.

 Vertauschen - Vertauscht die Stapelreihenfolge von zwei ausgewählten Objekten.

Verbinder und Klebepunkte

Verbinder sind spezifische Linien, die an Klebepunkten auf einem 
Objekt verankert oder angeklebt werden und standardmäßig am 
Objektrand positioniert sind. Wenn ein Objekt mit einem 
Verbindungselement verschoben oder in der Größe verändert wird, 
passt sich das Verbindungselement automatisch an die Änderung an 
(Abbildung 50). Bei der Erstellung von Flussdiagrammen, Organi-
grammen, Schemata oder Diagrammen ist es sehr empfehlenswert, 
Verbinder anstelle von Linien zu verwenden.
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Verbinder

Wenn ein Verbinder gezeichnet oder ausgewählt wird, zeigt 
Impress Ziehpunkte an, die sich von den Ziehpunkten für normale 
Linien unterscheiden. Die Endpunkte eines Verbinders sind an 
jedem Ende des Verbinders rund (Abbildung 51). Die quadrati-
schen Ziehpunkte an einer Verbindungslinie werden verwendet, 
um den Verlauf eines Verbinders zu ändern, wo dies möglich ist.

Impress bietet eine Vielzahl von vordefinierten Verbindern, die 
sich in der Form des Abschlusses (kein, Pfeil oder Kreis) und in 
der Art, wie der Verbinder erstellt wird (gerade, Linie oder 
gebogen), unterscheiden. In der Symbolleiste Verbinder (Abbildung 52) ist ein Standardsatz von 
Verbindertypen installiert.

Auf die gesamte Palette der vordefinierten Verbinder können Sie zugreifen, indem Sie auf das 
Dreieck  in der Titelleiste der Symbolleiste Verbinder KLICKEN und im Kontextmenü die Option 
Sichtbare Schaltflächen wählen. Je nach Betriebssystem und Einstellung des Computers sind 
Symbole unter Sichtbare Schaltflächen durch ein Häkchen oder eine Hervorhebung gekenn-
zeichnet, hier im Beispiel hellblau hervorgehoben (Abbildung 53). Weitere Informationen zum 
Installieren von Verbindern in der Symbolleiste Verbinder finden Sie in 
Impress Anhang B - Symbolleisten.

Abbildung 52: Symbolleiste „Verbinder‟
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Die Verbindertypen sind hier nummeriert, um die Einbauposition von links nach rechts in der 
Symbolleiste anzugeben.

1. Verbinder mit Pfeilende

2. Direktverbinder mit Pfeilende

3. Kurvenverbinder mit Pfeilende

4. Linienverbinder mit Pfeilende

5. Verbinder

6. Direktverbinder

7. Kurvenverbinder

8. Linienverbinder

9. Verbinder mit Pfeilen

10. Direktverbinder mit Pfeilen

11. Kurvenverbinder mit Pfeilen

12. Linienverbinder mit Pfeilen

13. Verbinder mit Pfeilanfang

14. Direktverbinder mit Pfeilanfang

15. Kurvenverbinder mit Pfeilanfang

16. Linienverbinder mit Pfeilanfang

17. Verbinder mit Kreisende

18. Direktverbinder mit Kreisende

19. Kurvenverbinder mit Kreisende

20. Linienverbinder mit Kreisende

21. Verbinder mit Kreisanfang

22. Direktverbinder mit Kreisanfang

23. Kurvenverbinder mit Kreisanfang

24. Linienverbinder mit Kreisanfang

25. Verbinder mit Kreisen

26. Direktverbinder mit Kreisen

27. Kurvenverbinder mit Kreisen

28. Linienverbinder mit Kreisspitzen
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Verbinder Typen

Standard (Verbinder)

Der Name des Verbinders beginnt mit Verbinder. Liniensegmente verlaufen vertikal und horizontal 
und bilden eine Verbindung mit einem oder mehreren 90°-Winkeln.

Direkt

Der Name des Verbinders beginnt mit Direkt. Besteht aus einer einzigen Linie und zeichnet eine 
gerade Verbindungslinie.

Kurven

Der Name des Verbinders beginnt mit Kurven. Gekrümmte Verbinder basieren auf Bézierkurven 
und krümmen sich um Objekte, wodurch ein gekrümmter Linienverbinder entsteht.

Linie

Der Name des Verbinders beginnt mit Linien. Besteht aus einem Liniensegment mit zwei kleineren 
Segmenten an den Enden und erzeugt einen Verbinder, der in der Nähe eines Klebepunkts 
abknickt. Um die Länge des Liniensegments zwischen einem Biegepunkt und einem Klebepunkt 
anzupassen, KLICKEN Sie auf den Verbinder und ziehen Sie den Biegepunkt.

Verbinder Zeichnen

1. KLICKEN Sie auf das Dreieck  neben Verbinder in der Symbolleiste Zeichnung, um die 
Symbolleiste Verbinder zu öffnen, Abbildung 52 auf Seite 46.

2. Wählen Sie in der Symbolleiste Verbinder den gewünschten Verbinder aus.

3. Bewegen Sie den Mauszeiger über eines der zu verbindenden Objekte. 
Daraufhin erscheinen kleine Kreuze  an den Objektkanten, die sich an der 
gleichen Stelle wie normalerweise die Ziehpunkte befinden. Diese Kreuze sind 
Klebepunkte, an denen ein Verbinder befestigt wird, wie in Abbildung 54 
gezeigt.

4. KLICKEN Sie auf den gewünschten Klebepunkt, um ein Ende des Verbinders zu befestigen, 
dann KLICKEN-HALTEN-ZIEHEN Sie den Verbinder zu einem anderen Objekt.

5. Wenn sich der Mauszeiger über dem Klebepunkt des Zielobjekts befindet, lassen Sie den 
Mauszeiger los und der Verbinder wird gezeichnet, das heißt, der Endpunkt des Verbinders 
rastet in den Klebepunkt ein.

6. Die quadratischen Ziehpunkte, die auf dem Verbinder erscheinen, werden verwendet, um 
die Position der Linie des Verbinders anzupassen. KLICKEN Sie auf einen quadratischen 
Ziehpunkt und ziehen Sie ihn, um den Verbinders so anzupassen, dass er kein anderes 
Objekt in seinem Pfad verdeckt, wie im Beispiel in Abbildung 55 gezeigt.

Abbildung 55: Drei Verbinder zwischen zwei Objekten
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Hinweis

Die Enden des Verbinders können nicht vertauscht werden, d.h. der Startpunkt kann 
nicht zum Endpunkt und der Endpunkt nicht zum Startpunkt werden. Sollen die Enden 
eines Verbinders vertauscht werden, muss ein neuer Verbinder in umgekehrter 
Richtung erstellt werden.

Verbinder Formatieren

Um einen Verbinder zu lösen oder neu zu positionieren, markieren Sie den Verbinder und KLICKEN 
Sie auf einen runden Endpunkt an einem der Enden des Verbinders und ziehen Sie ihn an eine 
andere Stelle, wie im Beispiel in Abbildung 55 dargestellt.

Um die Verbindungslinie zwischen Objekten zu ändern und dabei Objekte auf der Verbindungslinie 
zu vermeiden, KLICKEN Sie auf einen quadratischen Ziehpunkt auf der Verbindungslinie und ziehen 
Sie ihn an eine neue Position, wie im Beispiel in Abbildung 55 dargestellt.

Um einen Verbindertyp zu ändern, KLICKEN Sie mit der rechten Maustaste auf den Verbinder und 
wählen Sie Verbinder… aus dem Kontextmenü, um den Dialog Verbinder zu öffnen 
(Abbildung 56). In diesem Dialog können Sie einen Verbindertyp auswählen und die Verbinderei-
genschaften ändern.

Typ

Wählen Sie den Verbindertyp aus der Auswahl-Liste aus.

Linienversatz

Bestimmt die Schräglage der ausgewählten Verbindungslinie und zeigt das Ergebnis in der 
Vorschau des Dialogs an.

Linienabstand

Legt die Abstände für die Anschlüsse fest.

Anfang horizontal - Horizontaler Platzbedarf am Anfang des Verbinders.

Ende horizontal - Horizontaler Platzbedarf am Ende des Verbinders.

Anfang vertikal - Vertikaler Platzbedarf am Anfang des Verbinders.

Ende vertikal - Vertikaler Platzbedarf am Ende des Verbinders.

Vorschaufenster - Ein LINKSKLICK vergrößert die Vorschau, ein RECHTSKLICK verkleinert sie.
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Abbildung 56: Dialog „Verbinder‟

Klebepunkte

Klebepunkte sind nicht dasselbe wie die Ziehpunkte eines Objekts. Die Ziehpunkte dienen zum 
Verschieben oder Ändern der Form eines Objekts. Klebepunkte werden verwendet, um einen 
Verbinder an einem Objekt zu befestigen oder anzukleben, so dass der Verbinder an diesem 
Objekt befestigt bleibt, wenn sich das Objekt bewegt. Alle Objekte verfügen über Klebepunkte, die 
normalerweise nicht angezeigt werden und nur sichtbar sind, wenn in der Symbolleiste Zeichnung 
die Option Verbinder ausgewählt ist.

Um Klebepunkte an einem Objekt einzufügen, anzupassen oder zu löschen, öffnen Sie die 
Symbolleiste Klebepunkte (Abbildung 57) mit einer der folgenden Methoden:

• Gehen Sie im Menü auf Ansicht > Symbolleisten > Klebepunkte.

• Gehen Sie im Menü auf Bearbeiten > Klebepunkte.

• KLICKEN Sie in der Symbolleiste Zeichnung auf Klebepunkte.

Abbildung 57: Symbolleiste „Klebepunkte‟

Klebepunkt-Typen

Wenn die Symbolleiste Klebepunkte geöffnet wird, sind nur die sechs Symbole auf der linken Seite 
der Symbolleiste aktiv. Die übrigen sechs Symbole auf der rechten Seite der Symbolleiste werden 
nur aktiv, wenn Relativer Klebepunkt abgewählt ist.
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Dies sind die sechs Symbole auf der linken Seite der Symbolleiste Klebepunkte:

 Klebepunkt einfügen

Fügt einen Klebepunkt ein, wenn Sie zweimal auf ein Objekt KLICKEN. Siehe „Klebepunkte einfü-
gen‟ auf Seite 52 für weitere Informationen.

 Austrittsrichtung links

Der Verbinder wird an der linken Kante des ausgewählten Klebepunkts angebracht.

 Austrittsrichtung oben

Der Verbinder wird an der oberen Kante des ausgewählten Klebepunkts angebracht.

 Austrittsrichtung  rechts

Der Verbinder wird an der rechten Kante des ausgewählten Klebepunkts angebracht.

 Austrittsrichtung unten

Der Verbinder wird an der unteren Kante des ausgewählten Klebepunkts befestigt.

 Relativer Klebepunkt

Behält die relative Position eines ausgewählten Klebepunkts zu einem Objekt bei, wenn die Größe 
dieses Objekts geändert wird. Dieses Werkzeug ist standardmäßig ausgewählt, wenn die Symbol-
leiste Klebepunkte geöffnet wird.

Die sechs Werkzeuge auf der rechten Seite der Symbolleiste Klebepunkte werden nur aktiv, wenn 
Klebepunkt relativ abgewählt ist. Dazu muss mindestens ein Klebepunkt ausgewählt sein, mit 
einem zweiten KLICK auf den Klebepunkt.

 Klebepunkt horizontal links

Wenn ein Klebepunkt auf ein Objekt angewendet wird und die Größe des Objekts geändert wird, 
bleibt die horizontale Position des Klebepunkts in der gleichen Entfernung vom linken Rand des 
Objekts fixiert. Die vertikale Position des Klebepunkts ändert sich mit der Größenänderung des 
Objekts.

 Klebepunkt horizontal zentriert

Wenn ein Klebepunkt auf ein Objekt angewendet wird und die Größe des Objekts geändert wird, 
bleibt die horizontale Position des Klebepunkts im gleichen Abstand zum horizontalen Mittelpunkt 
des Objekts. Die vertikale Position des Klebepunkts ändert sich mit der Größenänderung des 
Objekts.

 Klebepunkt horizontal rechts

Wenn ein Klebepunkt auf ein Objekt angewendet wird und die Größe des Objekts geändert wird, 
bleibt die horizontale Position des Klebepunkts in der gleichen Entfernung vom rechten Rand des 
Objekts fixiert. Die vertikale Position des Klebepunkts ändert sich mit der Größenänderung des 
Objekts.

 Klebepunkt vertikal oben

Wenn ein Klebepunkt auf ein Objekt angewendet wird und die Größe des Objekts geändert wird, 
bleibt die vertikale Position des Klebepunkts im gleichen Abstand von der Oberkante des Objekts 
fixiert. Die horizontale Position des Klebepunkts ändert sich mit der Größenänderung des Objekts.

 Klebepunkt vertikal mittig

Wenn ein Klebepunkt auf ein Objekt angewendet wird und die Größe des Objekts geändert wird, 
bleibt die vertikale Position des Klebepunkts in der gleichen Entfernung von der vertikalen Mitte 
des Objekts fixiert. Die horizontale Position des Klebepunkts ändert sich mit der Größenänderung 
des Objekts.
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 Klebepunkt vertikal unten

Wenn ein Klebepunkt auf ein Objekt angewendet wird und die Größe des Objekts geändert wird, 
bleibt die vertikale Position des Klebepunkts im gleichen Abstand von der unteren Kante des 
Objekts fixiert. Die horizontale Position des Klebepunkts ändert sich mit der Größenänderung des 
Objekts.

Hinweis

In ein Objekt eingefügte Klebepunkte können nur eine horizontale Position und eine 
vertikale Position haben. Nur eine horizontale Position und/oder eine vertikale Position 
kann in der Symbolleiste Klebepunkte ausgewählt und zum Anpassen eines Klebe-
punkts verwendet werden.

Klebepunkte einfügen

Die meisten Objekte haben standardmäßig vier Klebepunkte. Fügen Sie wie folgt zusätzliche 
Klebepunkte in ein Objekt ein:

1. Verwenden Sie eine der folgenden Methoden, um die Symbolleiste Klebepunkte zu öffnen:

○ Gehen Sie im Menü zu Ansicht > Symbolleisten > Klebepunkte.

○ Gehen Sie im Menü zu Bearbeiten > Klebepunkte.

○ KLICKEN Sie in der Symbolleiste Zeichnung auf Klebepunkte.

2. Wählen Sie das Objekt aus und KLICKEN Sie dann in der Symbolleiste Klebepunkte auf 
Klebepunkt einfügen.

3. Bewegen Sie den Cursor an die Stelle, an der der Klebepunkt in ein Objekt eingefügt 
werden soll und KLICKEN Sie, um den Klebepunkt einzufügen.

4. Um weitere Klebepunkte einzufügen, bewegen Sie den Mauszeiger an eine neue Position 
und KLICKEN Sie, um einen weiteren Klebepunkt einzufügen.

5. Wenn der Klebepunkt ausgewählt ist, wählen Sie den gewünschten Klebepunkt-Typ aus 
den Optionen in der Symbolleiste Klebepunkte.

6. Um einen Klebepunkt an eine andere Position zu verschieben, KLICKEN Sie auf den Klebe-
punkt und ziehen ihn an seine neue Position.

7. Wenn das Einfügen von Klebepunkten abgeschlossen ist, vergewissern Sie sich, dass 
Klebepunkt einfügen in der Symbolleiste Klebepunkte abgewählt ist.

Tipp

Beim Einfügen, Verschieben oder Anpassen von Klebepunkten empfiehlt es sich, die 
Zoomfunktion zu verwenden, um die Arbeit mit Klebepunkten zu erleichtern. 
Außerdem rasten die Klebepunkte am Raster ein, was die Positionierung eines Klebe-
punktes erleichtert.

Hinweis

Nur Klebepunkte, die in ein Objekt eingefügt wurden, können angepasst oder gelöscht 
werden. Die an einem Objekt standardmäßig vorhandenen Klebepunkte, können nicht 
angepasst oder gelöscht werden.
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Anpassen der Austrittsrichtung des Klebepunkts

1. Vergewissern Sie sich, dass keine Objekte ausgewählt sind und verwenden Sie eine der 
folgenden Methoden, um die Symbolleiste Klebepunkte zu öffnen:

○ Gehen Sie im Menü zu Ansicht > Symbolleisten > Klebepunkte.

○ Gehen Sie im Menü zu Bearbeiten > Klebepunkte.

○ KLICKEN Sie in der Symbolleiste Zeichnung auf Klebepunkte.

2. KLICKEN Sie ein zweites mal auf einen eingefügten Klebepunkt, um den Klebepunkt für die 
Anpassung auszuwählen.

3. Wählen Sie eine Austrittsrichtung für den Verbinder aus den Optionen in der Symbolleiste 
Klebepunkte oder KLICKEN Sie mit der rechten Maustaste auf den Klebepunkt und wählen 
Sie die Klebepunkt-Austrittsrichtung aus dem Kontextmenü.

4. Wenn die Anpassung der Austrittsrichtung abgeschlossen ist, vergewissern Sie sich, dass 
Klebepunkt einfügen in der Symbolleiste Klebepunkte abgewählt ist.

Anpassen der Position eines Klebepunkts

1. Vergewissern Sie sich, dass keine Objekte ausgewählt sind und verwenden Sie eine der 
folgenden Methoden, um die Symbolleiste Klebepunkte zu öffnen:

○ Gehen Sie im Menü zu Ansicht > Symbolleisten > Klebepunkte.

○ Gehen Sie im Menü zu Bearbeiten > Klebepunkte.

○ KLICKEN Sie in der Symbolleiste Zeichnung auf Klebepunkte.

2. DOPPELKLICKEN Sie auf einen eingefügten Klebepunkt, um den Klebepunkt für die 
Anpassung auszuwählen.

3. KLICKEN Sie auf Relativer Klebepunkt in der Symbolleiste Klebepunkte, um dieses Symbol 
zu deaktivieren oder KLICKEN Sie mit der rechten Maustaste auf den Klebepunkt und deakti-
vieren Sie Relativer Klebepunkt aus dem Kontextmenü.

4. Wählen Sie die für den Klebepunkt erforderlichen horizontalen und vertikalen Positio-
nierungssymbole aus. Es kann immer nur ein horizontales und ein vertikales Positio-
nierungssymbol für einen Klebepunkt verwendet werden.

5. Wenn die Anpassung der Klebepunktposition abgeschlossen ist, stellen Sie sicher, dass 
Klebepunkt einfügen in der Symbolleiste Klebepunkte abgewählt ist.

Klebepunkte löschen

Vergewissern Sie sich, dass keine Objekte ausgewählt sind und verwenden Sie eine der folgenden 
Methoden, um die Symbolleiste Klebepunkte zu öffnen:

Gehen Sie im Menü zu Ansicht > Symbolleisten > Klebepunkte.

Gehen Sie im Menü zu Bearbeiten > Klebepunkte.

KLICKEN Sie in der Symbolleiste Zeichnung auf Klebepunkte.

Wählen Sie einen Klebepunkt aus, der zuvor eingefügt wurde.

Drücken Sie die ENTF- oder die RÜCK-Taste oder wählen Sie im Menü Bearbeiten > 
Ausschneiden.
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Arbeiten mit 3D-Objekten

Obwohl Impress erweiterte Funktionen zur Bearbeitung von 3D-Objekten bietet, werden in dieser 
Anleitung nur die 3D-Einstellungen beschrieben, die für ein Objekt gelten. Weitere Informationen 
zur Verwendung von erweiterten 3D-Effekten wie Geometrie und Schattierung finden Sie im 
Handbuch Draw Kapitel 7 - Arbeiten mit 3D Objekten.

Abbildung 58: Symbolleisten „3D-Objekte‟ und „3D-Einstellungen‟

3D-Objekte können in Impress auf eine der folgenden Arten erstellt werden:

• KLICKEN Sie auf das Dreieck  neben 3D-Objekte in der Symbolleiste Zeichnung und 
wählen Sie ein 3D-Objekt aus der Auswahl-Liste. Nach der Auswahl zeichnen Sie ein 3D-
Objekt genau so wie jedes andere Objekt. Das in der Symbolleiste Zeichnung angezeigte 
Symbol hängt davon ab, welches 3D-Objekt zuvor ausgewählt und verwendet wurde.

• Gehen Sie im Menü auf Ansicht > Symbolleisten > 3D-Objekte, um die Symbolleiste für 
3D-Objekte zu öffnen (Abbildung 58). Diese Symbolleiste entspricht der Symbolleiste 3D-
Objekte, die in der Symbolleiste Zeichnung verfügbar ist.

• KLICKEN Sie mit der rechten Maustaste auf ein bereits auf einer Folie gezeichnetes Objekt 
und wählen Sie im Kontextmenü die Option Umwandeln > In 3D oder > In 3D-Rotations-
körper. In 3D fügt dem Objekt eine Dicke hinzu, um ein 3D-Objekt zu erstellen. Mit In 3D-
Rotationskörper wird ein 3D-Objekt durch Drehen des Objekts um eine Achse erzeugt.

• Wählen Sie ein Objekt aus und KLICKEN Sie in der Symbolleiste Zeichnung auf Extrusion 
umschalten, um einen grundlegenden 3D-Effekt anzuwenden und die Symbolleiste 3D-Ein-
stellungen zu öffnen (Abbildung 58). Wählen Sie eine der Optionen in der Symbolleiste 3D-
Einstellungen, um einen anderen 3D-Effekt anzuwenden.
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3D-Objekte

1 Würfel

2 Kugel

3 Zylinder

4 Kegel

5 Pyramide

6 Torus

7 Schale

8 Halbkugel

3D-Einstellungen

1 Nach unten kippen

2 Nach oben kippen

3 Nach links kippen

4 Nach rechts kippen

5 Tiefe

6 Richtung

7 Beleuchtung

8 Oberfläche

9 3D-Farbe
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Folgende Optionen stehen in der Symbolleiste 3D-Einstellungen zur Verfügung:

Extrusion umschalten

Fügt einem Objekt eine Dicke hinzu und aktiviert die 3D-Eigenschaften. Sollte diese Option nicht 
auf der Symbolleiste vorhanden sein, können Sie sie über Sichtbare Schaltflächen im 
Kontextmenü der Symbolleiste hinzufügen.

Nach unten kippen - Kippt das Objekt nach unten um eine horizontale Achse.

Nach oben kippen - Kippt das Objekt nach oben um eine horizontale Achse.

Nach links kippen - Kippt das Objekt nach links um eine vertikale Achse.

Nach rechts kippen - Kippt das Objekt nach rechts um eine vertikale Achse.

Tiefe - Bestimmt die Dicke der Form. Es öffnet sich eine erweiterte Symbolleiste, in der einige 
Standardwerte angegeben sind. Wenn keiner der Werte zufriedenstellend ist, wählen Sie 
Benutzerdefiniert und geben Sie dann die gewünschte Dicke ein.

Richtung - Wenn Sie auf das Dreieck  neben Richtung KLICKEN, öffnet sich eine Symbolleiste, in 
der Sie die Richtung der Perspektive sowie den Typ (parallel oder perspektivisch) auswählen 
können.

Beleuchtung - Wenn Sie auf das Dreieck  neben Beleuchtung KLICKEN, öffnet sich eine Symbol-
leiste, mit der Sie die Richtung und Intensität des Lichts festlegen können.

Oberfläche - Wenn Sie auf das Dreieck  neben Oberfläche KLICKEN, öffnet sich eine Symbolleiste, 
in der Sie die Art der Oberfläche auswählen können: Drahtgitter (nützlich beim Formatieren eines 
Objekts), Matt, Kunststoff oder Metall.

3D-Farbe - Ein KLICK auf das Dreieck  neben 3D-Farbe öffnet eine Farbpalette zur Auswahl einer 
Farbe für die Objektdicke.

Hinweis

Die meisten der Fontwork-Formen (siehe „Fontwork‟ auf Seite 58) haben 3D-Eigen-
schaften und können mit der Symbolleiste 3D-Einstellungen formatiert werden.

Objekte umwandeln

Objekte werden mit einer der folgenden Methoden in verschiedene Typen konvertiert:

• KLICKEN Sie mit der rechten Maustaste auf das Objekt und wählen Sie im Kontextmenü die 
Option Umwandeln.

• Wählen Sie ein Objekt aus und gehen Sie in der Menüleiste auf Format > Umwandeln und 
wählen Sie eine Option aus dem Untermenü.

Die Optionen zum Umwandeln von Objekten in einen anderen Typ sind wie folgt:

In Kurve

Wandelt das ausgewählte Objekt in eine Bézier-Kurve um. KLICKEN Sie in der Symbolleiste Zeich-
nung auf Punkte, um die Punkte nach der Umwandlung in eine Bézier-Kurve zu bearbeiten.

In Polygon

Wandelt das ausgewählte Objekt in ein Polygon um. KLICKEN Sie in der Symbolleiste Zeichnung 
auf Punkte, um das Objekt nach der Umwandlung in ein Polygon zu bearbeiten. Ein Polygon 
besteht immer aus geraden Segmenten.
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In Kontur

Entspricht der Umwandlung von Grundformen in Polygone. Bei komplexeren Formen (oder bei 
Textobjekten) erzeugt diese Konvertierung eine Gruppe von Polygonen, die durch Eingabe der 
Gruppe formatiert werden kann.

In 3D

Wandelt das ausgewählte Objekt in ein 3D-Objekt um.

In 3D Rotationskörper

Erzeugt eine dreidimensionale Form durch Drehen des ausgewählten Objekts um seine vertikale 
Achse.

In Bitmap

Wandelt das ausgewählte Objekt in eine Bitmap um.

In MetaFile

Wandelt das ausgewählte Objekt in das Windows Metafile Format (WMF) um, das sowohl Bitmap- 
als auch Vektorgrafikdaten enthält.

Hinweis

Manchmal führt die Umwandlung in eine andere Art von Objekt nicht sofort zu sichtba-
ren Ergebnissen.
In Kurve, In Polygon, In 3D und In 3D-Rotationskörper gibt es zusätzliche Symbole, 
die der Symbolleiste Zeichnung über Sichtbare Schaltflächen hinzugefügt werden 
können. Weitere Informationen finden Sie in 
Impress Anhang B – Symbolleisten.

Interaktion mit Objekten

Die Verknüpfung eines Objekts mit einer Aktion, die ausgeführt wird, wenn ein Objekt ausgewählt 
wird, wird als Interaktion bezeichnet.

• Wählen Sie ein Objekt zur Interaktion aus und öffnen Sie den Dialog Interaktion 
(Abbildung 59) mit einer der folgenden Methoden:

• KLICKEN Sie in der Symbolleiste Linie und Füllung auf Interaktion.

• KLICKEN Sie mit der rechten Maustaste auf das Objekt und wählen Sie Interaktion aus 
dem Kontextmenü.

• Gehen Sie im Menü auf Format > Interaktion.

• Wählen Sie die Interaktion aus der Auswahl-Liste bei Aktion bei Mausklick und den eventu-
ell verfügbaren Parametern (falls zutreffend) aus. Der Dialog Interaktion ändert sich je nach 
Art der ausgewählten Interaktion. Die Interaktionen und Parameter werden in Tabelle 1 
erläutert.

• KLICKEN Sie auf OK , um die Änderungen zu speichern und den Dialog zu schließen.

Um eine Interaktion aus einem Objekt zu entfernen, wiederholen Sie den Vorgang und wählen Sie 
in Schritt 2 als Interaktionstyp Keine Aktion.
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Abbildung 59: Dialog „Interaktion‟

Tabelle 1: Interaktions-Arten und Parameter

Interaktion Parameter

Keine Aktion Keine Parameter.

Wechseln zur 
vorhergehen-
den Folie

Keine Parameter.

Wechseln zur 
nächsten Folie

Keine Parameter.

Wechseln zur 
ersten Folie

Keine Parameter.

Wechseln zur 
letzten Folie

Keine Parameter.

Wechseln zu 
Seite oder 
Objekt

KLICKen Sie auf das Ziel aus der Liste im Feld Sprungziel an. Suchen Sie im 
Feld Folie / Objekt am unteren Bildschirmrand nach einem bestimmten Ziel.

Wechseln zu 
Dokument

Wählen Sie ein Dokument im Feld Dokument aus. Verwenden Sie Durchsu -
chen , um einen Dateibrowser zu öffnen. Wenn das zu öffnende Dokument im 
ODP-Format vorliegt, wird die Zielliste ausgefüllt, so dass das spezifische Ziel 
ausgewählt werden kann.

Audio 
abspielen

Wählen Sie die Datei aus, die den abzuspielenden Ton enthält. Verwenden Sie 
Durchsuchen , um einen Dateibrowser zu öffnen und das Audio auszuwählen.

Programm 
ausführen

Wählen Sie das auszuführende Programm. Verwenden Sie Durchsuchen , um 
einen Dateibrowser zu öffnen und ein Programm auszuwählen.

Makro 
ausführen

Wählen Sie ein Makro aus, das während der Präsentation ausgeführt wird. 
Verwenden Sie Durchsuchen , um den Dialog Makro-Auswahl zu öffnen.

Präsentation 
beenden

Wenn der Cursor auf das Objekt GEKLICKT wird, wird die Präsentation beendet.
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Fontwork

Mit Fontwork werden grafische Textobjekte erstellt, um eine Präsentation attraktiver zu gestalten. 
Es gibt viele verschiedene Einstellungen dafür (Linie, Fläche, Position, Größe usw.), die eine große 
Auswahl an Effekten ermöglichen. Fontwork ist auch in den LibreOffice-Komponenten Writer, Calc 
und Draw verfügbar. Aber es gibt kleine Unterschiede in der Art und Weise, wie die einzelnen 
Komponenten Fontwork anzeigen. Weitere Informationen zu Fontwork finden Sie im Handbuch 
Erste Schritte – Kapitel 11 – Grafik, Galerie und Fontwork.

Fontwork erstellen

Gehen Sie im Menü auf Einfügen > Fontwork, um den Dialog Fontwork-Galerie zu öffnen 
(Abbildung 60).

Wählen Sie im Dialog eine Formatvorlage aus und KLICKEN Sie auf OK . Die ausgewählte Schrift-
art wird mittig auf der Folie angezeigt und der Dialog wird geschlossen.

DOPPELKLICKEN Sie auf die Fontwork-Textgrafik, um den Bearbeitungsmodus zu aktivieren.

Geben Sie den gewünschten Text ein, um den Standardtext in der Fontwork-Grafik zu ersetzen, 
der Text erscheint dann über dem Standardtext, wie im Beispiel in Abbildung 61 gezeigt.

Drücken Sie die ESC-Taste oder KLICKEN Sie außerhalb der Fontwork-Grafik, der eingefügte Text 
ersetzt nun den Standardtext.

Abbildung 60: Dialog „Fontwork-Galerie‟
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Abbildung 61: Beispiel: Fontwork erstellen

Symbolleiste „Fontwork‟

Die Symbolleiste Fontwork (Abbildung 62) wird sichtbar und aktiv, wenn ein Fontwork-Objekt 
ausgewählt ist. Wenn die Symbolleiste nicht sichtbar ist, gehen Sie im Menü auf Ansicht > 
Symbolleisten > Fontwork. Außerdem öffnet sich der Bereich Fontwork bei Eigenschaften in der 
Seitenleiste (Abbildung 62) und enthält die gleichen Werkzeuge wie die Symbolleiste Fontwork.

Abbildung 62: Symbolleiste „Fontwork‟ und „Fontwork‟ in der 
Seitenleiste

1 Fontwork-Text einfügen

2 Fontwork-Form

3 Fontwork-Buchstaben mit gleicher Höhe

4 Fontwork-Ausrichtung

5 Fontwork-Zeichenabstand

6 Extrusion umschalten

Fontwork Text einfügen - Öffnet den Dialog Fontwork Galerie.

Fontwork Form - Ändert die Form eines ausgewählten Objekts. Wenn Sie auf das Dreieck  neben 
Fontwork-Form KLICKEN, öffnet sich die Symbolleiste Fontwork-Form (Abbildung 63), in der Sie 
eine Fontwork-Form auswählen können.

Abbildung 63: Symbolleiste „Fontwork-Form‟

Fontwork-Buchstaben mit gleicher Höhe - Ändert die Höhe der Zeichen in einem ausgewählten 
Fontwork-Objekt. Schaltet zwischen normaler Höhe, bei der die Zeichen unterschiedlich hoch sind 
und gleicher Höhe für alle Zeichen, um.
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Fontwork-Ausrichtung - Legt die Textausrichtung innerhalb des Rahmens 
fest. Folgende Optionen sind verfügbar: 
Links ausrichten, Zentriert, Rechts ausrichten, Gestreckter Blocksatz
Abbildung 64. Die Auswirkungen der Textausrichtung sind nur zu sehen, 
wenn sich der Text über zwei oder mehr Zeilen erstreckt. Im Modus 
Gestreckter Blocksatz werden alle Zeilen vollständig ausgefüllt.

Fontwork-Zeichenabstand - Legt den Abstand zwischen den Zeichen fest 
und ob Unterschneidungspaare verwendet werden sollen. Die verfügba-
ren Optionen sind Sehr schmal, Schmal, Normal, Weit, Sehr weit und Anpas-
sen…, (Abbildung 65). Für Anpassen geben Sie einen Prozentwert ein: 100 % ist 
normaler Zeichenabstand, weniger als 100 % Zeichenabstand ist enger und mehr 
als 100 % Zeichenabstand ist weiter.

Extrusion umschalten - Konvertiert ein Fontwork-Objekt in eine 3D-Form durch 
Extrusion. Weitere Informationen finden Sie im Handbuch 
Draw Kapitel 7 - Arbeiten mit 3D Objekten.

Fontwork ändern

Es ist möglich, Fontwork-Text wie ein Objekt zu behandeln und alle Formatierungen anzuwenden, 
die in diesem Kapitel beschrieben wurden. Weisen Sie Fontwork nur Linieneigenschaften zu, die 
keinen 3D-Effekt haben, sonst sind die Änderungen nicht sichtbar. Ändern Sie auch einige der 
Fontwork-Formen, indem Sie den Punkt verschieben, der mit den Ziehpunkten angezeigt wird. 
Dies ist vergleichbar mit der Änderung der Winkel der Grundformen Trapez und Parallelogramm.

Animationen

Animierte Folienübergänge werden zwischen den Folien eingefügt, um Präsentationen beim 
Wechsel zur nächsten Folie ein professionelleres Aussehen zu verleihen (weitere Informationen zu 
Übergängen finden Sie in Impress Kapitel 9 - Bildschirmpräsentationen und Fotoalben). Impress 
ermöglicht auch das Hinzufügen von Animationen in den Folien, um die Präsentation interessanter 
zu gestalten.

Eine Animation besteht aus einer Abfolge von Bildern oder Objekten, den so genannten Frames 
(Einzelbilder), die nacheinander angezeigt werden, wenn die Animation läuft. Jeder Frame kann 
ein oder mehrere Objekte enthalten. Zum Beispiel Aufzählungspunkte, die nacheinander erschei-
nen; Bilder, Formen oder andere Objekte, die einzeln oder als Gruppe auf einer Folie erscheinen. 
Animationen werden über eine Tastatur, einen KLICK oder automatisch in einer zeitlich festgelegten 
Abfolge gesteuert.

Hinweis

Alles, was auf einer Folie platziert werden kann, ist ein Objekt. Ein Objekt kann zum 
Beispiel ein Bild, eine Clipart-Zeichnung, ein Text usw. sein.

Tipp

Animationen können in einer Präsentation gut aussehen, aber ein übermäßiger 
Einsatz von Animationen kann eine gute Präsentation in eine schlechte Präsentation 
verwandeln. Überlegen Sie, ob mit einer Animation das Präsentierte wirklich besser zu 
verstehen oder nur ein Showeffekt ist.
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Animationen erstellen

1. Wählen Sie ein Objekt auf einer Folie aus und öffnen Sie die Animation in der Seitenleiste 
(Abbildung 66) mit einer der folgenden Methoden:

○ KLICKEN Sie in der Seitenleiste auf Animation.

○ KLICKEN Sie mit der rechten Maustaste auf ein ausgewähltes Objekt und wählen Sie im 
Kontextmenü Animation.

○ Gehen Sie im Menü auf Ansicht > Animation.

2. KLICKEN Sie auf Hinzufügen , um das ausgewählte Objekt in das Vorschaufenster der 
Animation einzufügen.

3. Wählen Sie eine Kategorie aus den Optionen in der Auswahl-Liste Kategorie.

4. Wählen Sie einen Effekt-Typ aus den Optionen in der Liste Effekte aus.

5. Wählen Sie aus den Optionen in der Auswahl-Liste Starten aus, wie die Animation begin-
nen soll.

6. Wählen Sie aus den in der Auswahl-Liste Richtung verfügbaren Optionen aus, wie die 
Animation angezeigt werden soll. Die verfügbaren Optionen sind spezifisch für den in der 
Liste Effekte ausgewählten Effekt.

7. Geben Sie bei Dauer eine Zeit in Sekunden ein, wie lange die Animation ablaufen soll.

8. Geben Sie bei Verzögerung eine Zeit in Sekunden ein, nach der das animierte Objekt in 
der Präsentation erscheinen soll.

9. KLICKEN Sie gegebenenfalls auf die Schaltfläche Optionen , um den Dialog Effektoptionen 
zu öffnen, in dem Sie alle für die Animation erforderlichen Einstellungen vornehmen 
können. KLICKEN Sie dann auf OK , um den Dialog Effektoptionen zu schließen.

10. Ändern Sie bei Bedarf die Reihenfolge im Bereich Animation (Vorschau), in der das 
ausgewählte Objekt in der Animation erscheint, mit Nach oben ↑  oder Nach unten ↓  
unterhalb der Vorschau.

11. KLICKEN Sie auf Start , um eine Vorschau des Animationseffekts anzuzeigen.

12. Wählen Sie bei Bedarf die Option Automatische Vorschau, damit bei jeder Änderung der 
Animation eine Vorschau des Effekts angezeigt wird.

13. Wenn Sie zufrieden sind, starten Sie die Bildschirmpräsentation, um sie zu überprüfen.
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Abbildung 66: Seitenleiste „Animation‟

Animationswerkzeuge und Optionen

Mit den verfügbaren Optionen bei der Animation in der Seitenleiste können Sie steuern, wie eine 
Animation auf ein Objekt auf einer Folie angewendet wird.

+Hinzufügen  (Effekt hinzufügen) - Fügt ein ausgewähltes Objekt zur Animationsvorschau hinzu 
und fügt dem Objekt Animationseffekte hinzu.

-  (Effekt entfernen) - Entfernt ein ausgewähltes Objekt und seine animierten Effekte aus dem 
Animationsvorschaufenster.

↑  (Nach oben verschieben) - Verschiebt das ausgewählte Objekt und seinen Animationseffekt in 
der Reihenfolge der Animationseffekte, die auf ein Objekt angewendet wurden, nach oben.

↓  (Nach unten verschieben) - Verschiebt den ausgewählten Animationseffekt in der Reihenfolge 
der auf ein Objekt angewendeten Animationseffekte nach unten.

Kategorie: - Wählen Sie eine Kategorie aus den Optionen in der Auswahl-Liste.

Effekt: - Wählen Sie einen Animationseffekt aus den in der Liste verfügbaren Optionen.

Starten: - Wählen Sie aus der Auswahl-Liste aus, wie ein Animationseffekt beim Ausführen einer 
Animation beginnt:

Beim Klicken - Die Animation hält bei diesem Effekt bis zum nächsten KLICK an.

Mit Vorheriger - Die Animation läuft sofort.

Nach Vorheriger - Die Animation läuft, sobald die vorherige Animation endet.

Richtung: - Wählen Sie in der Auswahl-Liste aus, wie ein Animationseffekt auf der Folie erscheinen 
soll. Die verfügbaren Optionen hängen von dem ausgewählten Animationseffekt ab.
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Optionen  - Öffnet den Dialog Effektoptionen zum Anpassen und Anwenden von Optionen auf den 
Animationseffekt und das Timing.

Dauer: - Wählen Sie die Dauer des ausgewählten Animationseffekts in Sekunden.

Verzögerung: - Wählen Sie die Verzögerung in Sekunden, mit der der Animationseffekt beginnt.

Automatische Vorschau - Wählen Sie diese Option, um automatisch eine Vorschau eines 
Animationseffekts anzuzeigen, wenn dieser auf ein Objekt angewendet wird.

Start  (Effekt-Vorschau) – Hiermit Testen Sie die Animation.

Dialog „Effektoptionen‟

Tab „Effekt‟

Der Tab Effekt (Abbildung 67) enthält Optionen, die dem ausgewählten Animationseffekt 
entsprechen:

Abbildung 67: „Dialog Effektoptionen‟ – Tab „Effekt‟

Einstellungen|Richtung: - Legen Sie die Richtung des Animationseffekts aus den in der Auswahl-
Liste verfügbaren Optionen fest.

Erweiterung

Klang: - Wählen Sie aus der Auswahl-Liste einen Ton aus, der beim Ausführen des Animations-
effekts abgespielt wird.

Nach der Animation: - Wählen Sie in der Auswahl-Liste aus, was nach dem Ende eines 
Animationseffekts geschehen soll:

- Nicht abblenden - es wird kein Nacheffekt ausgeführt.

- Mit Farbe abblenden - nach der Animation füllt eine gedämpfte Farbe die Form aus.

- Nach der Animation ausblenden - verbirgt die Form nach dem Ende der Animation.

- Mit nächster Animation ausblenden - blendet die Form bei der nächsten Animation aus.
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Farbe abblenden: - Wählen Sie eine gedämpfte Farbe aus den verfügbaren Farbpaletten.

Textanimation: - Wählen Sie den Animationsmodus für den Text in einem Objekt:

- Gemeinsam - animiert den gesamten Text auf einmal.

- Wortweise - animiert den Text Wort für Wort.

- Zeichenweise - animiert den Text Buchstabe für Buchstabe.

Verzögerung zwischen Zeichen - Gibt die prozentuale Verzögerung zwischen den Animationen von 
Wörtern oder Buchstaben an.

Abbildung 68: Dialog „Effektoptionen‟ - Tab „Anzeigedauer‟

Tab „Anzeigedauer‟

Der Tab Anzeigedauer im Dialog Effektoptionen (Abbildung 68) enthält die folgenden Optionen:

Zeitwahl

Starten: - Zeigt die Starteigenschaft des ausgewählten Animationseffekts an.

- Beim Klicken - die Animation stoppt bei diesem Effekt bis zum nächsten KLICK.

- Mit Vorheriger - die Animation läuft sofort ab.

- Nach Vorheriger - die Animation läuft, sobald die vorherige Animation endet.

Verzögerung: - Gibt eine Verzögerung in Sekunden an, bevor der Effekt einsetzt.

Dauer - Gibt die Dauer des Effekts in Sekunden an.

Wiederholung: - Legt fest, ob und wie der aktuelle Effekt wiederholt werden soll. Geben Sie die 
Anzahl der Wiederholungen ein oder wählen Sie aus der Liste:

- keine - der Effekt wird nicht wiederholt.

- Bis zum nächsten Klick - die Animation wird bis zum nächsten KLICK wiederholt.

- Bis zum Ende der Folie - die Animation wird so lange wiederholt, wie die Folie angezeigt 
wird.
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Nach der Wiedergabe zurückspulen - Gibt an, ob das animierte Objekt nach Beendigung der 
Animation in seinen Ausgangszustand zurückkehren soll.

Auslöser

Animation als Teil der Klickreihenfolge - Gibt an, ob die Animation in der normalen Klicksequenz 
beginnen soll.

Effekt starten beim Klicken auf: - Gibt an, ob die Animation starten soll, wenn eine bestimmte Form 
ANGEKLICKT wird. Wählen Sie die Form anhand ihres Namens aus der Auswahl-Liste aus.

Abbildung 69: Dialog „Effektoptionen‟ - Tab „Lauftext‟

Tab „Lauftext‟

Der Tab Lauftext im Dialog Effektoptionen (Abbildung 69) enthält die folgenden Optionen:

Text gruppieren: - Gibt an, wie der Text animiert wird.

- Als einzelnes Objekt

- Alle Absätze auf einmal - Alle Textabsätze sind animiert.

- Nach der 1. Abschnittsebene - Nach Absätzen der Stufe nn. Der Text für die ausgewählte 
Gliederungsebene wird animiert. Die verfügbaren Optionen hängen davon ab, wie viele 
Gliederungsebenen der animierte Text hat.

Automatisch nach: - Gibt eine Verzögerung in Sekunden an, bevor der Textanimationseffekt 
beginnt.

Angefügte Form animieren - Animiert ein Objekt, das Text enthält.

In umgekehrter Reihenfolge - Textabschnitte werden in umgekehrter Reihenfolge animiert.
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Weitere Informationen

Handbücher der LibreOffice Community

Die Handbücher für die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die Kapitel-
übersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

LibreOffice Handbücher (englische Versionen) / 
https://wiki.documentfoundation.org/Documentation/Publications

LibreOffice bietet sechs Anwendungen (Komponenten) für die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

• Writer - Textverarbeitung

• Calc - Tabellenkalkulation

• Impress - Präsentationen

• Draw - Zeichnungen

• Base - Datenbanken

• Math - Formeleditor

Die Kapitel

Jeder, der sich schnell mit LibreOffice vertraut machen möchte, wird die Kapitel zu schätzen 
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit eine anderen Office-Suite 
vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen

Alle Kapitel können frei als PDF-Version heruntergeladen werden:

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren

Die Handbücher werden von Freiwilligen der LibreOffice-Community erstellt.

Über LibreOffice

LibreOffice ist eine leistungsfähige Office-Suite, für verbreitete Betriebssysteme wie Windows, 
GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.

LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der Gemeinschaft der 
Stiftung The Document Foundation / https://de.libreoffice.org/about-us/governance/. Die Stiftung 
hat ihren Sitz in Berlin / Deutschland.

Das Programm LibreOffice kann unter der Adresse LibreOffice Download / 
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.
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Kapitelübersicht - Impress Handbuch

Kapitel 0 - Vorwort

Kapitel 1 - Einführung

Kapitel 2 - Masterfolien, Formatvorlagen, Dokumentvorlagen

Kapitel 3 - Text hinzufügen und formatieren

Kapitel 4 - Bilder hinzufügen und formatieren

Kapitel 5 - Grafikobjekte verwalten

Kapitel 6 - Grafikobjekte formatieren

Kapitel 7 - OLE, Tabellen, Diagramme und andere Objekte

Kapitel 8 - Folien, Notizen, Kommentare und Handzettel hinzufügen und formatieren

Kapitel 9 - Bildschirmpräsentationen und Fotoalben

Kapitel 10 - Bildschirmpräsentationen speichern, Drucken, E-Mail-Versand und Export

Kapitel 11 - Impress anpassen

Kapitel 12 - Varianten der Benutzeroberfläche

Anhang A - Tastaturkürzel

Anhang B - Symbolleisten
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Hilfe

So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe

Die Offline-Hilfe steht Ihnen nur zur Verfügung, wenn Sie sie auch installiert haben.

Platzieren Sie den Cursor an eine Stelle (Menü, Dialog etc.), an der Sie Hilfe benötigen.

Betätigen Sie die Taste F1, (bei Laptops evtl. FN+F1).

Online-Hilfe

Die Online-Hilfe wird Ihnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.

Sie können die Online-Hilfe aber auch direkt in Ihrem Internetbrowser öffnen:

LibreOffice online Hilfe

Offline- und Online-Hilfe

Beide Hilfesysteme öffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.

Im oberen Bereich befindet sich die Suchleiste. Dort können Sie Ihre Suchbegriffe eingeben. 
Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl von 
Themen. Mit jedem weiterem Buchstaben konkretisiert sich die Auswahl.

KLICKEN Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren Bereich 
des Fenster zu lesen.

Noch Fragen?

Für Fragen zum Thema gehen Sie zu Ask.LibreOffice:

Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice

Besuchen Sie uns auch auf der Seite Dabei sein!:

LibreOffice Community

Spenden

LibreOffice ist freie Software und wird kostenfrei zur Verfügung gestellt. Ihre Spende, die rein 
freiwillig ist, unterstützt unsere weltweite Gemeinschaft. Wenn Ihnen die Software gefällt, freuen 
wir uns über eine Spende auf Spenden für die Document Foundation.
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